LASER WHEEL PROFILOMETER
IKP-5 Series, Model 2017 Year

User's manual

22, Logoisky tract, Minsk
220090, Republic of Belarus
tel/fax: +375 17 357 36 57
info@riftek.com
www.riftek.com
Contents

1. Safety precautions and measurement conditions ........................................ 5
2. CE compliance ............................................................................................. 5
3. Laser safety ................................................................................................. 5
4. General information ................................................................................. 5
5. Basic technical data .................................................................................. 6
6. Example of designation when ordering ...................................................... 7
7. Complete set to be supplied ...................................................................... 7
8. Device structure ......................................................................................... 8
    8.1. Basic components of the device and their functions ......................... 8
    8.1.1. Digital readout device ..................................................................... 9
    8.1.2. Laser scanning module ................................................................... 10
    8.1.3. Calibration block ............................................................................ 12
8. Operation principle .................................................................................... 12
9. Geometric parameters of the wheel under control .................................... 12
    10.1. Flange height, sH............................................................................... 12
    10.2. Flange thickness, sD.......................................................................... 13
    10.3. Flange slope, qR................................................................................. 14
    10.4. Wear parameters ................................................................................ 14
    10.5. Angle parameters .............................................................................. 15
    10.6. Rim parameters .................................................................................. 16
    10.7. Wheel diameter .................................................................................. 16
    10.8. Parameters of tram wheels ................................................................. 16
    10.9. Wheel defects ..................................................................................... 17
11. Coordinate system .................................................................................... 17
12. First activation and measurement procedure .......................................... 18
    12.1. Activation ......................................................................................... 18
    12.2. Measurement ..................................................................................... 19
13. PDA program setting ............................................................................... 21
    13.1. Measurement type ............................................................................. 21
    13.2. Units of measurement ....................................................................... 21
    13.3. Date/time setting .............................................................................. 22
    13.4. Device selection ................................................................................ 22
    13.5. Language setting ................................................................................ 24
    13.6. Synchronization with PC .................................................................. 24
14. Measurement parameters setting ............................................................ 25
    14.1. Calculation methods setting ............................................................... 26
    14.2. Selection of displayed parameters ...................................................... 26
    14.3. L-parameters setting ......................................................................... 26
    14.4. Preset parameters values ................................................................... 27
15. Setting the database parameters, tolerances and measurements schemes .. 28
    15.1. Selection of the current database ......................................................... 28
    15.2. Reference profile selection and installation ....................................... 29
    15.2.1. Writing the reference profile to the database ................................. 30
    15.3. Selection and formation of the measurement scheme .................... 30
    15.3.1. Selection or removal of the measurement scheme........................ 30
    15.3.2. Formation of a new measurement scheme .................................... 31
    15.3.3. Loading of a new measurement scheme ....................................... 31
    15.4. Setting of tolerances ......................................................................... 31
    15.5. Wheel type selection and installation ................................................. 32
16. Updating of PDA software .................................................................... 33
17. Shutdown .................................................................................................. 34
18. Measurements with database maintenance ............................................. 34
21. Installation of software on PC and startup
   21.1. Installation of database support software ...
   21.2. Synchronization of PDA and PC ...
   21.3. Program startup ...
22. User settings of the program
   22.1. Parameters setting ...
      22.1.1. "Wheelset's parameters" tab ...
      22.1.2. "Calculated parameters" tab ...
      22.1.3. "L-parameters" tab ...
      22.1.4. "Measurement method" tab ...
      22.1.4.1. Selection of measurement units ...
   22.2. Database settings ...
      22.2.1. Setting the path to database ...
      22.2.2. Creation of empty database ...
      22.2.3. Import of database ...
      22.2.4. Selection of software language ...
      22.2.4.1. Preparation and installation of the language support file ...
   22.3. Registration data ...
      22.3.1. Selection of the organization ...
      22.3.2. Registration of operators ...
      22.3.3. Registration of series ...
      22.3.4. Registration of car/locomotive numbers ...
      22.3.5. Registration of tolerances ...
      22.3.6. Registration of reference profiles ...
      22.3.6.1. Request and registration of the profile file ...
23. Data exchange between PDA and PC ...
   23.1. ActiveSync synchronization ...
      23.1.1. Transfer of database file to PC ...
      23.1.2. Transfer of language file from PC to PDA ...
      23.1.3. Transfer of language file from PDA to PC ...
      23.1.4. Transfer of reference profile files from PC to PDA ...
      23.1.5. Transfer of processing scheme file from PC to PDA ...
      23.1.6. Updating of PDA software ...
   23.2. Mass Storage synchronization ...
24. Working with profilograms and wear calculations ...
   24.1. Browsing the graph and profile coordinates ...
   24.2. "Parameters" tab ...
      24.2.1. Selecting a profile to compare ...
      24.2.2. Selecting L-parameters values ...
      24.2.3. Geometric parameters of the profile ...
   24.3. Wear calculation ...
      24.3.1. Fast wear calculation ...
      24.3.2. Wear calculation at all points ...
      24.3.3. Export to Excel, DXF, REF ...
   24.4. Alignment of profiles ...
   24.5. Superposition of profiles ...
   24.6. Rescaling ...
25. Implementation of minimum wheel truing function ...
26. Scanning and editing of data ...
   26.1. Scanning and filtering of data ...
27. Taking measurements under PC control (without PDA) ...........................................67
   27.1. Calibration ........................................................................................................68
   27.1.1. Bluetooth-connection ..................................................................................68
   27.1.2. Calibration of the profilometer .....................................................................69
   27.2. Measurement by using PC ..............................................................................70
   27.2.1. Saving of data ..............................................................................................70
29. Annex 2. Program for creating the measurement schemes ..................................71
   30.1. Preparation for testing/calibration .................................................................73
   30.2. Testing ............................................................................................................74
   30.3. Calibration ......................................................................................................76
   30.4. Restoring the factory settings .........................................................................77
31. Annex 4. Software application for working with the “A.U.R.A. Wheel” system ....78
   31.1. Installation ......................................................................................................78
   31.2. Settings ..........................................................................................................78
      31.2.1. Language ..................................................................................................79
      31.2.2. Gauge type selection ..............................................................................79
      31.2.3. Password ..................................................................................................82
      31.2.4. Calculation methods ...............................................................................83
      31.2.5. Selection of displayed parameters .........................................................83
      31.2.6. L-parameters ............................................................................................84
      31.2.6.1. Preset values .......................................................................................84
      31.2.7. Reference profile selection and installation ...........................................85
      31.2.7.1. Writing the reference profile to the database ......................................85
      31.2.8. Measurement scheme .............................................................................85
      31.2.8.1. Selection or removal of the measurement scheme ...............................86
      31.2.8.2. Formation of a new measurement scheme ..........................................86
      31.2.9. Tolerances .................................................................................................87
      31.2.10. Vehicles ...................................................................................................88
   31.3. Measurements .................................................................................................88
      31.3.1. Single measurement ................................................................................89
      31.3.2. Simple measurement ...............................................................................90
      31.3.2.1. Measurement ......................................................................................92
      31.3.2.2. Measuring by IDK, IMR .....................................................................95
      31.3.3. Automated measurement .......................................................................96
32. Warranty policy ......................................................................................................98
33. List of changes ....................................................................................................98
34. Distributors ..........................................................................................................98
35. RIFTEK’s measurement devices for railway transport .........................................102
1. **Safety precautions and measurement conditions**
   - Prior to mounting the profilometer onto the wheel, areas of contact of the side supports with the wheel surface should be thoroughly cleaned from dirt.
   - When mounting the module on the wheel, do not allow heavy shocks of its support against the wheel.
   - The output window of the profilometer and profilometer supports must be carefully inspected and cleaned.
   - Do not use laser module in locations close to powerful light sources.

2. **CE compliance**
   The profilometers have been developed for use in industry and meet the requirements of the following Directives:
   - EU directive 2014/30/EU. Electromagnetic compatibility (EMC).

3. **Laser safety**
   The profilometer make use of a c.w. 660 (or 405) nm wavelength semiconductor laser. Maximum output power is 1 mW. The device belongs to the 2 laser safety class according IEC/EN 60825-1:2014. The following warning label is placed on the profilometer body:

   ![Warning Label]

   The following safety measures should be taken while operating the profilometer:
   - Do not target laser beam to humans.
   - Do not disassemble the sensor.
   - Avoid staring into the laser beam.

4. **General information**
   A laser profilometer IKP5 Series is designed for measuring of
   - wheel flange height
   - wheel flange thickness
   - wheel flange slope
   - rim thickness
   - full profile scanning and analyze of wheel rolling surface
   - maintaining of electronic wear data base
   - control of tolerances and sorting in the course of checkup, examination, repair and formation of railway wheel sets.

   Measurements are made directly on rolling stock without wheel set roll-out.

   Profilometers are implemented in three configurations: with the standard handle, with the shorten handle (Short version) and very short handle (Super short version). The version with the shorten handle is intended to measure the wheels with the limited space for installing the profilometer. The version with very short handle is specially designed to measure wheels of **Ansaldo Breda low floor trams** with very limited space for profilometer installing. This super short profilometer version has separate battery block, connected by cable with laser module.
5. **Basic technical data**

<table>
<thead>
<tr>
<th>Name of parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Measurement range</strong></td>
<td></td>
</tr>
<tr>
<td>Flange height, mm</td>
<td>20…45</td>
</tr>
<tr>
<td>Flange thickness, mm</td>
<td>20…50</td>
</tr>
<tr>
<td>Flange slope, mm</td>
<td>1…15</td>
</tr>
<tr>
<td>Rim thickness, mm</td>
<td>36…100 (30…90)</td>
</tr>
<tr>
<td>Diameter (calculation method), mm</td>
<td>400…1400</td>
</tr>
<tr>
<td><strong>Measurement error</strong></td>
<td></td>
</tr>
<tr>
<td>Flange height, mm</td>
<td>± 0.03</td>
</tr>
<tr>
<td>Flange thickness, mm</td>
<td>± 0.03</td>
</tr>
<tr>
<td>Flange slope, mm</td>
<td>± 0.1</td>
</tr>
<tr>
<td>Rim thickness, mm</td>
<td>± 0.1</td>
</tr>
<tr>
<td>Diameter, mm</td>
<td>± 0.1</td>
</tr>
<tr>
<td><strong>Discreteness of indication</strong></td>
<td></td>
</tr>
<tr>
<td>All parameters, mm</td>
<td>0.01</td>
</tr>
<tr>
<td>Profile measurement range, mm</td>
<td>145</td>
</tr>
<tr>
<td>Discreteness of the profile formation, not worse than, mm</td>
<td>0.025 (5800 points for profile)</td>
</tr>
<tr>
<td>Digital readout device (PDA) dimensions, mm</td>
<td>see Fig. 3</td>
</tr>
<tr>
<td>Dimensions of laser scanning module, mm</td>
<td>see Fig. 5</td>
</tr>
<tr>
<td>Measurement time, s</td>
<td>adaptive, depending on surface quality, 4 average</td>
</tr>
<tr>
<td>Power supply (laser scanning module)</td>
<td>3.7V</td>
</tr>
<tr>
<td>Li-ion rechargeable battery</td>
<td></td>
</tr>
<tr>
<td>5400mAh for standard IKP and</td>
<td></td>
</tr>
<tr>
<td>2400mAh for Short and Super-short</td>
<td></td>
</tr>
<tr>
<td>The number of measurements that can be taken before battery recharge is not less than</td>
<td>5000 for standard IKP and 2200 for Short and Super-short</td>
</tr>
<tr>
<td>Laser module battery life time</td>
<td>5 million measurement cycles</td>
</tr>
<tr>
<td>Power supply (PDA)</td>
<td>3.7V</td>
</tr>
<tr>
<td>Li-polymer battery</td>
<td></td>
</tr>
<tr>
<td>3300mAh</td>
<td></td>
</tr>
<tr>
<td>PDA memory capacity</td>
<td>100 000 measurements</td>
</tr>
<tr>
<td>Interface between laser scanning module and PDA</td>
<td>Bluetooth</td>
</tr>
<tr>
<td>Working temperature range, °C</td>
<td>-20…+50</td>
</tr>
<tr>
<td>Enclosure rating</td>
<td>IP42 or IP64</td>
</tr>
</tbody>
</table>
6. Example of designation when ordering

IKP-V-M-S-T-R

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>V</td>
<td>Profilometer version:&lt;br&gt;without symbol - Standard version&lt;br&gt;Short - Short handle&lt;br&gt;SShort - Super short handle&lt;br&gt;SShort-EB - Super short handle and external battery</td>
</tr>
<tr>
<td>S</td>
<td>Options of the support plates embodiment:&lt;br&gt;D – direct. Standard plates, profilometer is mounted on the internal rim face (specified by default).&lt;br&gt;I – invert. Custom plates, profilometer is mounted on the external rim face.</td>
</tr>
<tr>
<td>T</td>
<td>Presence of the rim measurement rod.</td>
</tr>
<tr>
<td>R</td>
<td>Enclosure rating:&lt;br&gt;without symbol - IP42&lt;br&gt;64 - IP64</td>
</tr>
</tbody>
</table>

Example:
IKP-T – standard magnets; standard support plates; presence of the rim measurement rod.
IKP-F-I – reinforced magnets; custom support plates.
IKP-Short-T - the shorten handle; presence of the rim measurement rod.

7. Complete set to be supplied

<table>
<thead>
<tr>
<th>Designation</th>
<th>Name</th>
<th>Quantity</th>
<th>Weight, kg</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF303M</td>
<td>Digital readout device (PDA)</td>
<td>1</td>
<td>0.3</td>
</tr>
<tr>
<td>RF505</td>
<td>Laser scanning module</td>
<td>1</td>
<td>0.8</td>
</tr>
<tr>
<td>RF505.40</td>
<td>Charging device 5V 1.0A for PDA and laser module</td>
<td>2</td>
<td>0.2</td>
</tr>
<tr>
<td>RF505.42</td>
<td>Data cable</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>RF505.43</td>
<td>Bluetooth adapter</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>RF505.30</td>
<td>Packing case</td>
<td>1</td>
<td>1.2</td>
</tr>
<tr>
<td>IKP5_DB</td>
<td>Database management system (CD)</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>RF505UM</td>
<td>User's manual</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>

Calibration tools (option):

<table>
<thead>
<tr>
<th>Designation</th>
<th>Name</th>
<th>Quantity</th>
<th>Weight, kg</th>
</tr>
</thead>
<tbody>
<tr>
<td>RF505.11</td>
<td>Calibration block</td>
<td></td>
<td>4</td>
</tr>
<tr>
<td>RF505Calibr</td>
<td>Calibration software</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The profilometer comes in the special case that protects the device against any possible damage.

8. Device structure

8.1. Basic components of the device and their functions

Fig. 1 shows basic components of the device:

Figure 1

(1) Digital readout device (personal digital assistant, PDA)
(2) Laser scanning module
(3) Calibration block
(4) Charging device
(5) Data cable
8.1.1. Digital readout device

Digital readout device (PDA) is designed for control of the laser scanning module, data reception from the scanning module, indication of measurement results, parameter input, and data storage.

Figure 2

Fig. 2 indicates:
(1) Turn-on button
(2) Charging indication, red/blue LED
(3) Connector to PC USB-port or charging device
(4) Flash memory card connector
(5) Stylus
(6) Bluetooth antenna

Overall dimensions of PDA are shown in Figure 3:
8.1.2. Laser scanning module

The module is intended for laser scanning of the wheel surface.

Fig. 4 indicates:
(1) Turn ON button
(2) Indicator of turn ON (red LED)
(3) Indicator of Bluetooth connection (blue LED)
(4) Charging device connector
(5) Support for mounting of the device on the wheel flange
(6) Magnetic support for mounting on the wheel side surface
(7) Charging indication, red/green LED
(8) Output window
(9) Rim measurement rod

**IKP-T**

Overall dimensions of the standard scanning module are shown in Figure 5.
- **IKP-Short-T**
  
  Overall dimensions of the scanning module with a short handle are shown in Figure 6.

- **IKP-SShort**
  
  Overall dimensions of the scanning module with a very short handle (Super Short version) are shown in Figure 6.1.

- **IKP-SShort-EB**
  
  Overall dimensions of the scanning module with a very short handle and an external battery are shown in Figure 6.2.
8.1.3. Calibration block

Calibration block is intended for calibration and tests of the profilometer. Calibration block is a metal imitator of the part of wheel with a definite profile.

Overall dimensions of calibration block are shown in Figure 1A of paragraph 30.3. Also possible is supply of a unit with a profile made to the customer’s drawings.

9. Operation principle

Operator mounts the laser scanning module onto the wheel to be measured. Having received a command from PDA or PC, the laser module performs non-contact scanning of the wheel surface. Measurement results (geometric parameters and profile of the surface) are displayed on PDA, can be saved in the PDA memory, and transferred to the PC database. Simultaneously, additional parameters can be saved: operator number, side identifier (left or right wheel), axis number, locomotive (carriage) number, wheel pair number, etc.


10. Geometric parameters of the wheel under control

Geometric parameters of the wheel are calculated automatically after laser scanning of the wheel is completed. To calculate geometric parameters, use is made of reference points on the wheel profile. Location of the reference points is defined by L- and P-parameters. Values of L- and P-parameters preset in PDA are given in paragraph 14.4, and can be changed by the user.

10.1. Flange height, sH

Calculation of the flange height is determined by parameter L2. The flange height is calculated as a distance measured vertically between the flange top and the point of wheel rolling surface at any preselected distance (L2) away from the inner face of the wheel tire.
10.2. Flange thickness, sD

Calculation of the flange thickness is determined by parameter L3 that specifies Point 1 on the flange surface. There are two ways to specify the parameter:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height L3 is measured vertically upward from a point of the wheel rolling surface, the position of which is defined by parameter L2.</td>
<td>Height L3 is measured vertically downward from the flange top.</td>
</tr>
</tbody>
</table>

The flange thickness is calculated as a distance measured horizontally at any preselected height (L3) between two points (Point 1 and Point 2) lying on the opposite sides of the flange top.

There are two ways to calculate the flange thickness:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Method 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Point 1 is defined by parameter L3. Point 2 is the intersection point of a horizontal line and a line lying on the internal face of the wheel.</td>
<td>Point 1 is defined by parameter L3. Point 2 is the intersection point of a horizontal line and the flange surface.</td>
</tr>
</tbody>
</table>

Note: Both calculation methods can be performed simultaneously.
10.3. Flange slope, qR

Calculation of the flange slope is determined by parameters L1 and L3 (or L4).

Height L1 is measured vertically downward from the flange top and determines Point 3 on the flange surface.
Height L4 is measured vertically upward from a point of the wheel rolling surface, the position of which is defined by parameter L2 (wheel rolling circle), and determines Point 4 on the flange surface.
Height L3 is described in paragraph 10.2.

There are three ways to calculate the flange slope:

<table>
<thead>
<tr>
<th>Method 1</th>
<th>Calculation in millimeters</th>
</tr>
</thead>
<tbody>
<tr>
<td>The flange slope is calculated as a distance measured horizontally between Point 3 and Point 1 (or 4). The PDA screen displays information in millimeters.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Method 2</th>
<th>Calculation in degrees</th>
</tr>
</thead>
<tbody>
<tr>
<td>The slope is calculated as the inclination angle of a straight line passing through Point 1 or 4. The PDA screen displays information in degrees.</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Method 3</th>
<th>Pass/Fail</th>
</tr>
</thead>
<tbody>
<tr>
<td>The calculation is performed according to Method 1. The PDA screen displays information only about whether the measured slope meets the tolerance conditions or not.</td>
<td></td>
</tr>
</tbody>
</table>

10.4. Wear parameters

The following wear parameters are calculated automatically:

<table>
<thead>
<tr>
<th>Wear parameter</th>
<th>Calculation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical wear</td>
<td>$W_t$ is calculated as the difference between the measured flange height and the flange height of the selected reference.</td>
</tr>
<tr>
<td>Horizontal wear</td>
<td>$W_f$ is calculated as the difference between the measured flange thickness and the flange thickness of the selected reference at height L3.</td>
</tr>
<tr>
<td>Corner wear</td>
<td>$W_r$ is calculated as the distance along the normal to the tangent at the point at height L5 from the wheel rolling circle of the measured profile, and the selected reference.</td>
</tr>
</tbody>
</table>
* Red color indicates the worn profile

<table>
<thead>
<tr>
<th>Hollow</th>
<th>HI</th>
<th>is calculated as the difference between the maximum and minimum values within the specified limits. The search limits:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>- parameters of the minimum value [P7_1..P7_2]</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- parameters of the maximum value [P8_1..P8_2]</td>
</tr>
</tbody>
</table>

**Hollow**

**Hl** is calculated as the difference between the maximum and minimum values within the specified limits. The search limits:
- parameters of the minimum value [P7_1..P7_2]
- parameters of the maximum value [P8_1..P8_2]

**Difference of diameters**

**dD** is calculated as the difference between diameter at point D1 and diameter at point D2.

**Even wear**

**W1** is the maximum vertical wheel wear selected from several measurements.

**Uneven wear**

**W2** is the difference between the maximum wheel wear and the minimum wheel wear (selected from several measurements).

### 10.5. Angle parameters

The following profile parameters are calculated automatically:

<table>
<thead>
<tr>
<th>Inclination</th>
<th>A</th>
<th>is calculated as the profile inclination angle (in degrees) at a point with coordinate L8.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Angle 1</td>
<td>S1</td>
<td>is calculated as the inclination angle of the straight line (in percents) passing through points on the wheel surface located at preset distance L6 from the wheel face and the distance L6+10mm from the wheel face.</td>
</tr>
<tr>
<td>Angle 2</td>
<td>S2</td>
<td>is calculated as the inclination angle of the straight line (in percents) passing through points on the wheel surface located at preset distance L7 from the wheel face and the distance L7+10mm from the wheel face.</td>
</tr>
</tbody>
</table>
10.6. Rim parameters

The following rim parameters are calculated automatically:

<table>
<thead>
<tr>
<th>Rim width</th>
<th>L</th>
<th>is calculated as a distance measured vertically between the internal and the external basic wheel surface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rim thickness</td>
<td>sT</td>
<td>is calculated as a distance measured vertically between the internal rim diameter and a point on the wheel rolling circle located on any preset distance L2 away from the wheel face.</td>
</tr>
</tbody>
</table>

L11 is an external wheel diameter.

10.7. Wheel diameter

Diameter | D       | is calculated by the formula: D = 2T + L10,  
T – rim thickness  
L10 – diameter of the wheel center |

10.8. Parameters of tram wheels

The following parameters of the tram wheels profile are calculated automatically:

<table>
<thead>
<tr>
<th>Flange thickness</th>
<th>sD15</th>
<th>is calculated as a distance measured horizontally at the set height (L15) between two points: 1st point is at the internal flange surface, 2nd point is at the line lying on the internal face of the wheel surface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flange thickness</td>
<td>Df</td>
<td>is calculated as a distance measured horizontally at the set height (L3) from the surface of the wheel rolling circle between two points lying on opposite sides from the flange top.</td>
</tr>
<tr>
<td>Reverse slope</td>
<td>f</td>
<td>is calculated as a distance measured horizontally from the point on the internal flange side at the set height (L3) to the point on the line lying on the internal face of the wheel.</td>
</tr>
</tbody>
</table>
10.9. **Wheel defects**

The following parameters of defects of the wheel surface are calculated:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Formula</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slide</td>
<td>$s_P$</td>
<td>is calculated as a difference of the wear measurements in two places of the wheel: on the slide and close to it (in the place without defects) at any preset distance ($L_2$) from the wheel face.</td>
</tr>
<tr>
<td>Cavity size</td>
<td>$h_R$</td>
<td>is calculated as a difference of the wear measurements in two places of the wheel: on the cavity and close to it (in the place without defects) at any profile point.</td>
</tr>
<tr>
<td>Cavity area</td>
<td>$s_R$</td>
<td>is calculated in the place of the maximum deviation.</td>
</tr>
</tbody>
</table>

11. **Coordinate system**

When comparing the profiles, two variants of location of the coordinate system of the wheel is possible to use.

<table>
<thead>
<tr>
<th>Coordinate system origin</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Top</td>
<td>When comparing and displaying profiles, the coordinate system origin is located at the intersection point of lines passing through the profile top and the internal wheel surface.</td>
</tr>
<tr>
<td>Wheel rolling circle</td>
<td>When comparing and displaying profiles, the coordinate system origin is located at the intersection point of lines passing through the wheel rolling circle.</td>
</tr>
</tbody>
</table>
12. First activation and measurement procedure

Charge accumulators of the laser module and indication device by connecting them to charging devices (see par. 28).

12.1. Activation

- Turn the PDA on by pressing the button (1), Fig. 2. The PDA screen will show the main program window containing: main menu; indicators of PDA and laser module charging degree; indicator of Bluetooth connection.

<table>
<thead>
<tr>
<th>Button</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device</td>
<td>Setting the PDA basic parameters (p.13)</td>
</tr>
<tr>
<td>Parameters</td>
<td>Setting the measurement parameters (p.14)</td>
</tr>
<tr>
<td>Settings</td>
<td>Setting parameters of database, tolerances, and others (p.15)</td>
</tr>
<tr>
<td>Profiles</td>
<td>View the wheelset profile (p.20.2.)</td>
</tr>
<tr>
<td>Measurement</td>
<td>Run the measurement process (p.12.2.)</td>
</tr>
</tbody>
</table>

- Switch the laser module on by pressing and holding button 1 (Fig. 4) for several seconds. When connecting the laser module, a red LED blinks (2). After the laser module is switched on, some time will pass until automatic wireless communication is set between the profilometer and the PDA, which is accompanied by blinking of a blue LED (3) on the laser module. The LED goes out when the link is established.
- The main program window will be updated.

The Measurement button, indicator of Bluetooth connection, serial number of the laser scanning module, and indicators of the charging degree will be active.
12.2. Measurement

There are two types of measurements:
1. Rapid measurements without saving the results.
2. Measurements by using the selected scheme with saving results to database.

The measurement procedure by using type 2 is described in par. 18. How to select the measurement type see in par. 13.1.

Measurement by using the scheme (type 2) is used for full-featured work with the profilometer with maintaining the database of measurements.

**Attention!**
Before installing the scanning module onto the wheel, you need to remove the dirt from the areas, where the laser scanning module will be in contact with the wheel surface.
When installing the laser scanning module onto the wheel, avoid of strong impacts of its supports, because it can lead to incorrect operation of the profilometer.

You need to inspect periodically the output window and basic supports of the laser scanning module and to clean them of dirt.
Do not clean the glass by using abrasive and aggressive cleaning agents.

To perform the measurement, it is necessary to:
- Fix the laser module on the calibration unit or wheel by mounting the module support (5) onto the wheel flange and pressing magnetic support (6) to the internal face of the wheel.
- For the rim measurement, extract the rim measurement rod and hitch it up to the rim.
- Make sure that the module is mounted correctly without any misalignment and gaps.
- Press the Measurement button on the PDA display.
- With the Measurement button pressed, the laser module will scan the wheel surface. During scanning time of about 1-2 seconds a red LED (2) is lit.
- When scanning is competed, the PDA will show values of measured parameters selected for presentation (see par. 14.2.).

![Rim thickness measurement rod](image-url)
When the parameter goes beyond set limits its value is highlighted with red color:

The **Reference** option enables/disables the display of the reference profile parameters on the screen (highlighted in green).

- To view the wheel profile click the **Profile** button, and the PDA display will show the scanned wheel profile, the measured parameters, and parameters of calibration unit (or a wheel, chosen as a reference):

- If you scan the calibration block or the reference wheel and scanning results differ from the reference values by nor more than 0.1 mm, the device is ready to work, otherwise it must be calibrated in accordance with par. 27.1 or 30.

The **Save** button is not active in the **Rapid measurements** mode.
13. **PDA program setting**

Prior to starting work with the profilometer, PDA program setting must be performed.

The window of basic parameters setting is called by pressing the Device button in the main program window (par. 12.1):  

<table>
<thead>
<tr>
<th>Button</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measure type</td>
<td>Rapid measurements/measurements with saving results to database</td>
</tr>
<tr>
<td>Units of measurement</td>
<td>Millimeters/inches</td>
</tr>
<tr>
<td>Date/time</td>
<td>Date/time setting</td>
</tr>
<tr>
<td>Device type</td>
<td>Device selection (IKP, IDK, IMR)</td>
</tr>
<tr>
<td>Language</td>
<td>Language selection</td>
</tr>
<tr>
<td>Synchronization</td>
<td>Synchronization with PC</td>
</tr>
</tbody>
</table>

13.1. **Measurement type**

Two measurement types are available:

1. Rapid measurements without saving the results.
2. Measurements by using the selected scheme with saving results to database.

To set the measure type, press the Measure type button. Then select the measure type: **Rapid measurement** or **Measurement by scheme**. Press the Save button.

13.2. **Units of measurement**

All parameters as well as measurement results can be presented in the Metric system (millimeters), or in the English system of units (inches). To set the units of measurement, press the Units button. Next, select **Millimeters (mm)** or **Inches (in)**, and press Save.
13.3. Date/time setting

Press the Date/Time button and set the date and time by using the buttons. Press the Save button.

13.4. Device selection

The PDA Bluetooth-connection is automatically configured to work with the laser scanning module supplied with the PDA. Moreover, the PDA provides operation with other IKP scanning modules and measurement instruments for railway transport manufactured by RIFTEK (Wheel Diameter Measuring Gauge, IDK; Back-to-Back Distance Measuring Gauge, IMR).

To connect other devices, press the Device type button. The device selection window contains 3 types of devices available for connecting to PDA: IKP, IDK, IMR.

Each type of devices has a list of available devices (with which the connection has been established earlier, and which have been saved in the IKP memory).

If the needed device is in the list, you can select it and press the Select button. The PDA will try to connect to the selected device.
To add a new device, press the **Add** button. The **Device searching** window will appear:

![Device searching window](image1)

To search for devices, press **Start** and wait for the search to complete:

![Device searching window](image2)

Detected devices (with their serial numbers) will appear on the screen:

![Device searching window](image3)

Next, select the device and press the **Save** button to save the address of a new device.

![Save device window](image4)
You can delete the device that you do not use anymore by pressing the Delete button.

13.5. Language setting

It is possible for the user to change the program language, form his own language support files as well as change/edit the terminology used.

To select the language, press the Language button. Next, select the required language support file and press the Select button.

If no such file is available, it is necessary to use the new files preparation procedure, which is described in par. 22.2.4.1., and then load a new language file from PC to PDA as it is shown in par. 23.1.3.

13.6. Synchronization with PC

To transfer data between PDA and PC, it is necessary to synchronize them. There are two ways of synchronization via USB cable.

When you select MS ActiveSync, synchronization with PC is performed via the ActiveSync software (Windows XP), or via Windows Mobile Device Center (Windows 7).

When you select Mass Storage, the device is detected in Windows as an external storage device.

To select the type of synchronization, press the Synchronization button in the Device window. Next, select the required type and press Save.
To apply the changes, PDA will prompt you to restart. If you do not need to sync the PDA with PC currently, you can restart the PDA later.

14. Measurement parameters setting

The Parameters window, which is called from the main program window, is intended for calculation settings of controlled parameters.

<table>
<thead>
<tr>
<th>Button</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings</td>
<td>Calculation methods setting</td>
</tr>
<tr>
<td>Show param.</td>
<td>Selection of displayed parameters</td>
</tr>
<tr>
<td>L Parameters</td>
<td>L Parameters setting</td>
</tr>
</tbody>
</table>
14.1. Calculation methods setting

To select the calculation method, press the Settings button. The following window will appear:

After selecting the required parameters, press the Save button to save changes.

14.2. Selection of displayed parameters

To enter the mode, press the Show param. button.

To select/deselect the parameter to display, double-click in the Show/Hide column opposite to the required parameter. After selecting, you need to press Save.

14.3. L-parameters setting

To set L-parameters, press the L Parameters button. In the table will be displayed only those parameters, which are necessary to calculate the selected geometrical parameters of the wheel.

To edit the parameters, double-click in the Value column opposite to the required parameter, and enter a new value in the Data Input window. Press the Enter button - ⬤.
When you have set all parameters, press the **Save** button to save them.

### 14.4. Preset parameters values

Values of L-parameters preset in the PDA are given in the Table:

<table>
<thead>
<tr>
<th>L-parameter</th>
<th>Default value</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>2 mm</td>
<td>Used for calculation of the flange slope (qR)</td>
</tr>
<tr>
<td>L2</td>
<td>70 mm</td>
<td>Defines position of the wheel rolling circle, and used for calculation: - flange height (sH) - flange thickness (sD) - flange slope (qR) - inclination angle (A) - wheel diameter (D) - rim thickness (T) - wear (Wt, Wf, Wr)</td>
</tr>
<tr>
<td>L3</td>
<td>13 mm</td>
<td>Used for calculation: - flange thickness (sD) - flange slope (qR) - wear (Wf)</td>
</tr>
<tr>
<td>L4</td>
<td>13 mm</td>
<td>An additional point for calculation of the flange slope (qR)</td>
</tr>
<tr>
<td>L5</td>
<td>10 mm</td>
<td>Used for calculation of an angular wear (Wr)</td>
</tr>
<tr>
<td>L6</td>
<td>70 mm</td>
<td>Used for calculation of slope of the rolling surface section (S1)</td>
</tr>
<tr>
<td>L7</td>
<td>105 mm</td>
<td>Used for calculation of slope of the rolling surface section (S2)</td>
</tr>
<tr>
<td>L8</td>
<td>10 mm</td>
<td>Used for measurement of the profile inclination angle at the required point (A)</td>
</tr>
<tr>
<td>L9</td>
<td>140 mm</td>
<td>Used for inverting the measurement direction (L9 – profile width)</td>
</tr>
<tr>
<td>L10</td>
<td>599.35 mm</td>
<td>Used for calculation of the profile diameter (D)</td>
</tr>
<tr>
<td>L11</td>
<td>767 mm</td>
<td>Used for calculation of the reference profile rim thickness (T)</td>
</tr>
<tr>
<td>L15</td>
<td>13 mm</td>
<td>Used for calculation of the flange thickness of tram wheels (sD15)</td>
</tr>
<tr>
<td>P7_1</td>
<td>50 mm</td>
<td>Used for calculation of the hollow (Hi)</td>
</tr>
<tr>
<td>P7_2</td>
<td>105 mm</td>
<td></td>
</tr>
<tr>
<td>P8_1</td>
<td>110 mm</td>
<td></td>
</tr>
<tr>
<td>P8_2</td>
<td>130 mm</td>
<td></td>
</tr>
<tr>
<td>D1</td>
<td>70 mm</td>
<td>Used for calculation of the hollow (Hi)</td>
</tr>
<tr>
<td>D2</td>
<td>107.5 mm</td>
<td></td>
</tr>
</tbody>
</table>
15. Setting the database parameters, tolerances and measurements schemes

The Settings window is intended to set the database parameters, tolerances, measurements schemes, etc.

<table>
<thead>
<tr>
<th>Button</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database</td>
<td>Database selection</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference profile selection</td>
</tr>
<tr>
<td>Scheme</td>
<td>Setting of measurement scheme</td>
</tr>
<tr>
<td>Tolerance</td>
<td>Setting of tolerances</td>
</tr>
<tr>
<td>Wheel type</td>
<td>Wheel type selection</td>
</tr>
</tbody>
</table>

15.1. Selection of the current database

You can save the measurement results to the PDA database, when it is necessary. The program makes it possible to create and to store several database files related to the date of measurement.

To select the database file, press the Database button.

To create a new database, press the Add button. The window for entering a name of a new database will appear.

By default, it will be prompted to form the database file with the name wp_yy_mm_dd.ikp, where yy_mm_dd is the current date:
- yy – the last two digits of the year;
- mm – month;
- dd – day.

You can agree with this name, or enter another:
Press the Enter button -

To select a database from a list, activate the line and press Select. The selected file will be marked with a "dot" symbol.

To delete the database file, activate the line and press Delete. If you delete the current database, the error message will appear.

15.2. Reference profile selection and installation

The program allows to compare the scanned profile of the wheel with the reference profile. To select the reference profile, press the Reference button.

To select the reference file, activate the line and press Select. The selected file will be marked with a "dot" symbol.

To delete the reference file, activate the line and press Delete. If you delete the current reference, the error message will appear.
15.2.1. **Writing the reference profile to the database**

Reference profiles are stored in the PDA database as profile description files with .ref extension. The PDA is supplied with several pre-installed profiles.

If there is no required reference profile in the database, the user can request the missing profile from **RIFTEK** (free service), and then transfer the received profile to the PDA as shown in Par. 23.1.4.

15.3. **Selection and formation of the measurement scheme**

The measurement scheme is meant as a sequence of making measurements/processing of wheels in the rolling stock with specified parameters of each wheelset (wheelset numbers, car numbers, series, etc.). The program automatically offers the operator to perform measurement of the wheel in accordance with selected scheme of wheel processing. The program contains several preset schemes. Besides, the user can form his own measurement scheme.

15.3.1. **Selection or removal of the measurement scheme**

To select the measurement scheme file, press the **Scheme** button.

To view the scheme, you need to activate the line containing the scheme file name and to press the **View** button.

Arrows in the figure show direction of processing of wheel pairs as well as the names assigned to wheels (1L-first axis, left side; 2L-second axis, left side; 1R-first axis, right side, etc.).

To select the scheme file, activate the respective line and press **Select**. The selected file will be marked with the symbol ".".

To delete the scheme file, activate the respective line and press **Delete**. If you delete the current scheme, the error message will appear.
15.3.2. **Formation of a new measurement scheme**

To form a new measurement scheme, press **Add**. The window for entering the measurement scheme name will appear.

Type the scheme name by using the on-screen keyboard. Then press the **Enter** button.

Next:
- select the number of cars;
- select the number of axles;
- select the wheel processing scheme out of the options suggested;
- press **Save**.

You can look at the formed scheme by pressing the **View** button.

This method of the measurement scheme formation allows to create only simple schemes without specifying the wheelset numbers, car numbers, series, etc. To form a complete scheme, see par. 29.

15.3.3. **Loading of a new measurement scheme**

If you can not create a new scheme as described in the previous paragraph, you can use the special program for PC (see par. 29), and then upload that scheme to the PDA as described in par. 23.1.5.

15.4. **Setting of tolerances**

The program automatically controls measured geometric parameters for going out beyond the tolerances set. It is possible for the user to create groups of tolerances. Control of parameters will be performed for a selected group.

To select the current group of tolerances, press the **Tolerance** button.

The table will show tolerances only for the selected geometric parameters of the wheel.

The red color indicates the maximum/minimum critical values of parameters. The orange color indicates the maximum/minimum values, which are close to critical values.
To select the group of tolerances, activate the line and press Select. The selected file will be marked with a "dot" symbol.

To delete the tolerance, activate the line and press Delete. If you delete the current tolerance, the error message will appear.

To edit the tolerance, activate the line and press Edit.

To add a new tolerance, activate the line with the type name and press Add. You will see on the screen:

```
<table>
<thead>
<tr>
<th>Name of Tolerance</th>
<th>Min</th>
<th>War.Min</th>
<th>War...</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
```

To change the type name, it is necessary to set cursor in the Name of Tolerance field, and to enter a new value in the appeared window. Then press the Enter button.

To edit the value, it is necessary to double-click on the Min/Max/War.Min/War.Max column opposite to the specific parameter, and to enter a new value in the emerged window. Then press the Enter button. If any parameter has a zero value, the tolerance will not be used.

To save changes, press Save.

### 15.5. Wheel type selection and installation

If several wheels types are used, it is possible to set definite measurement scheme, reference profile and L-parameters for every wheel type.

For example, we have three types of wheels: WheelType1, WheelType2, WheelType3. Every time for a new wheel type we can measure L-parameters, scheme, reference and tolerances, or we can define these values for every wheel type, and select only the required type.

**Example**

- WheelType 1: Reference 1, Scheme 1, Tolerance 1, L-Parameters 1;
- WheelType 2: Reference 2, Scheme 2, Tolerance 2, L-Parameters 2;
- WheelType 3: Reference 3, Scheme 3, Tolerance 3, L-Parameters 3;

To select the wheel type, press the Wheel type button.

To select the wheel type, activate the respective line and press Apply. The selected file will be marked with the symbol ".". 
To delete the wheel type, activate the respective line and press **Delete**. If you delete the current type, the error message will appear.

To edit the wheel type, activate the respective line and press **Edit**.

To add a new wheel type, activate the line with the type name and press **Add**. View on the screen:

![New wheel type](image)

To change the type name, it is necessary to set cursor in the **Name** field, and to enter a new value in the appeared window. Then press the **Enter** button - ![Save](image).

Next:
- select the reference profile (**Reference**);
- select the scheme (**Scheme**);
- select the tolerance (**Tolerance**);
- set Settings (**Settings** button, see par. 14.1.);
- set the displayed parameters (**Show param.** button, see par. 14.2.);
- set L-parameters (**L Parameters** button, see par. 14.3.);
- press **Save**.

16. **Updating of PDA software**

You can view the software version in the main program window:

![Software version](image)

The latest software version can be downloaded from the website: [www.riftek.com/media/documents/ikp/ikp5_PDA_Software.zip](http://www.riftek.com/media/documents/ikp/ikp5_PDA_Software.zip)

Procedure of PDA software updating is described in par. 23.1.6. of this manual.
17. Shutdown

To shutdown the PDA, press the **Shutdown** button - .

18. Measurements with database maintenance

There are two types of measurements:

1. Rapid measurements without saving the results.
2. Measurements by using the selected scheme with saving results to the database.

Procedure of rapid measurements is described in par. 12. How to select the measurement type, see par. 12.2.

The second type is used for a fully functional work with the profilometer with maintenance of the measurements database.

When Bluetooth-connection is established, you can start to measure by pressing the **Measurement** button in the main program window. The window of wheelset parameters will appear on the screen:

Parameters fields will be filled in accordance with the selected measurement scheme. If needed, you can fill/edit the required fields, and press the **Save** button to save changes. The selected scheme will be displayed on the screen:
Designations and buttons:

<table>
<thead>
<tr>
<th>Designation</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 (6)</td>
<td>an ordinal number of the car to be measured</td>
</tr>
<tr>
<td></td>
<td>(number of cars in the rolling stock)</td>
</tr>
<tr>
<td>Car</td>
<td>edit the wheelset parameters</td>
</tr>
<tr>
<td>Previous/Next</td>
<td>pass to the previous/next wheel</td>
</tr>
<tr>
<td>Previous/Next</td>
<td>pass to the previous/next car</td>
</tr>
<tr>
<td>Measured</td>
<td>a measured wheel</td>
</tr>
<tr>
<td>Non-measured</td>
<td>a wheel to be measured next time</td>
</tr>
<tr>
<td>Non-measured</td>
<td>a non-measured wheel</td>
</tr>
<tr>
<td>A</td>
<td>a measured wheel to be measured again</td>
</tr>
<tr>
<td>Measurement</td>
<td>measurement</td>
</tr>
</tbody>
</table>

18.1. Measurement

- Press the **Measure** button in order to measure the wheel offered by the program (highlighted in green). The laser module will scan the wheel surface.
- Upon completion of the scanning process, the PDA will show the values of selected geometrical parameters.

![Wheel parameters](image)

When the value is beyond the tolerances, it will be highlighted in red:

![Wheel parameters](image)

The program allows to display only parameters of the measured profile. To hide the reference values, you need to untick the **Reference** box.
To view the wheel profile, press the **View** button - . The scanned wheel profile and the selected reference profile will be displayed on the PDA screen.

For more information, see par. 20.2.

- To repeat the measurement, press the **Measure** button.
- When a satisfactory result is obtained, press the **Save** button to save it.
- The program will offer to pass to the measurement of the next wheel in accordance with the selected scheme of measurement.

- To view the results of previous measurements, you can use the arrows. If you select the measured wheel, the saved wheel parameters will be displayed on the PDA screen.
- When you measure the wheel that was already measured, the program prompts you to replace the existing database file with the new one.

18.2. Measurement of even/uneven wear

Measurement of an even/uneven wear is slightly different from a standard measurement. To obtain the result of the wear, it is necessary to perform several measurements at different points of the wheel. When passing to the measurement window, an additional button Accept will appear on the screen.

After each performed measurement, you need to press Accept to save current values of the wear. At subsequent measurements the program will automatically find the maximum and minimum wear of the wheel and calculate an even/uneven wear.
When a satisfactory result is obtained, press the **Save** button to save it.

### 18.3. Measurement of defects

IKP allows to measure defects of wheelsets.
- Slide size (sP)
- Cavity size (hR)
- Cavity area (sR)

Measurement of defects differs from the standard measurement.

The procedure of measuring the slide (cavity) is described below:
- Perform the measurement at the profile point that do not have any defects (slides, cavities), which can be detected visually.

- If you obtained a satisfactory result, press the **Apply** button. The checkboxes **Slide** and **Cavity** will appear on the screen.

- Select the defect that you need to measure (tick the required checkbox).
- Place the profilometer properly (a laser beam must pass through the measured defect).
- Press the **Measure** button to start the measurement.
Upon completion of the measurement, the program calculates the value of selected parameter.
When a satisfactory result is obtained, press **Save** to save data to database.

19. **Measuring by IKP, IDK, IMR, and saving to database**

How to use the PDA with other devices is described in the corresponding User's Manuals.

It is often needed that the measurement results obtained from different devices were stored in one database. In this case, all entered parameters of the specific wheelset must be the same in all devices.

These parameters are:
- Date
- N wheelset
- Series
- Number
- Axle
- Side (besides IMR)

20. **Browsing the database**

To browse the saved data, press the **Profiles** button in the main window. The PDA screen will display information about the current database, quantity of saved profiles, table with saved profiles, and measured values of selected parameters.

<table>
<thead>
<tr>
<th>Date</th>
<th>Series</th>
<th>Number</th>
<th>Axle</th>
<th>R/A</th>
<th>N wheelset</th>
<th>Measured</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>06/01/16 CM3</td>
<td>7102</td>
<td>13</td>
<td>L</td>
<td>5,00011</td>
<td>21.92</td>
<td>21.92 mm</td>
<td></td>
</tr>
<tr>
<td>06/01/16 CM3</td>
<td>7102</td>
<td>13</td>
<td>L</td>
<td>5,00011</td>
<td>21.92</td>
<td>21.92 mm</td>
<td></td>
</tr>
<tr>
<td>06/01/16 CM3</td>
<td>7102</td>
<td>14</td>
<td>R</td>
<td>5,00011</td>
<td>21.92</td>
<td>21.92 mm</td>
<td></td>
</tr>
<tr>
<td>06/01/16 CM3</td>
<td>7102</td>
<td>12</td>
<td>R</td>
<td>5,00011</td>
<td>21.92</td>
<td>21.92 mm</td>
<td></td>
</tr>
</tbody>
</table>

**Buttons:**
- **Browse the profile of selected wheel**
- **Delete the selected wheel**
20.1. **Data filtering**

To add a filter, you need to press the **Filter** button, and to set filter parameters in the appeared window.

An example of filtering by the **Axle** parameter:

![Filter window]

The filtered field will be highlighted in yellow:

![Filtered data]

To delete the current filter, you need to press **Cancel**.

20.2. **Visualization of the wheel profile**

To browse the wheel profile, you need to press the **Profile** button - **Profile**. The scanned wheel profile and the profile of selected reference will be displayed on the PDA screen.

![Profile visualization]
21. Installation of software on PC and startup

21.1. Installation of database support software

The ikp5_DB software is intended for maintaining wheel sets wear database on a personal computer (the updated version of the program can be downloaded from www.riftek.com/media/documents/ikp/Ikp5_PC_Software.zip).

To install the software, insert a compact disk to the PC CD drive, select and start the Install_Ikp5.exe file in the Software folder. Follow guidelines of the installation wizard. By default, the software will be installed in the following directory C:\Program Files (x86) \Riftek, LLC\Ikp5_db\.

21.2. Synchronization of PDA and PC

There are two ways of synchronization via USB cable to transfer data between PDA and PC:
- MS ActiveSync
- Mass Storage
When you select **MS ActiveSync**, synchronization with PC is performed via the **ActiveSync** software (Windows XP), or via **Windows Mobile Device Center** (Windows 7), which must be installed on PC.

It is necessary to select **MS ActiveSync** as the synchronization type (see par. [13.6](#)).

When you select **Mass Storage**, the device will be detected in Windows as an external storage device.

It is necessary to select **Mass Storage** as the synchronization type (see par. [13.6](#)).

To check if the **MS ActiveSync** synchronization is correct, switch on the PDA and connect it to the USB port of the PC by the supplied cable. If the connection is successful, a message about it will appear on the screen:

### 21.3. Program startup

To start the program, click **Start > All programs > Riftek, LLC > IKP5_DB > Ikp5_DB.exe**. View of the main program window is shown below.
22. User settings of the program

22.1. Parameters setting

To go to the window of parameters setting, click Settings > Parameters in the main window, or click ☐.

The window of parameters contains 4 tabs:
- Wheelset's parameters
- Calculated parameters
- L parameters
- Measurement method

22.1.1. "Wheelset's parameters" tab

This tab is intended to select parameters, which will be displayed on the screen when viewing the database.

If the parameter is ticked, its value will be shown in the table of results and in the table of profiles.
22.1.2. "Calculated parameters" tab

This tab is intended to select the wheelset geometrical parameters, which will be calculated and displayed on the screen when viewing the database.

<table>
<thead>
<tr>
<th>Wheelset parameters</th>
<th>Calculated parameters</th>
<th>L-parameters</th>
<th>Measurement method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height (m)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thickness (mm)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thickness (BD)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parameter (F)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Beadline (g)</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tie (T)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shade (R)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Angle (E)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hollow (H)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Width (W)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Back-to-Back distance (M)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Multiple measurements (M)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Description and functions of parameters are the same as in the PDA software (see par. 10.).

22.1.3. "L-parameters" tab

This tab is intended to set the values of reference points for calculated geometrical parameters of the wheelset.

<table>
<thead>
<tr>
<th>Wheelset parameters</th>
<th>Calculated parameters</th>
<th>L-parameters</th>
<th>Measurement method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter L1</td>
<td>2.00</td>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>Parameter L2</td>
<td>70.00</td>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>Parameter L3</td>
<td>1.00</td>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>Parameter L10</td>
<td>14976.50</td>
<td>mm</td>
<td></td>
</tr>
<tr>
<td>Parameter L15</td>
<td>10.00</td>
<td>mm</td>
<td></td>
</tr>
</tbody>
</table>

Description and functions of the reference points are the same as in the PDA software (see par. 10.).

22.1.4. "Measurement method" tab

This tab is intended to select the calculation method.

<table>
<thead>
<tr>
<th>Wheelset parameters</th>
<th>Calculated parameters</th>
<th>L-parameters</th>
<th>Measurement method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parameter L3 from:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Rolling circle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Flange</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gradient</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- From L1 to L3</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- From L1 to L4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gradient inc.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Millimeters</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Degrees</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Accept/Accept</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Units measure</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- mm</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- inch</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Thickness from:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Inner dia.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Flange</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Both values</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Year</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Height</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Equal/Unequal</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coordinates center</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Flange top</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Rolling circle</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Involved profile</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- No</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>- Yes</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Description and functions of the measurement methods are the same as in the PDA software (see par. 10.).
22.1.4.1. Selection of measurement units

All parameters and measurement results can be in the Metric system (millimeters), or in the English system (inches).

To set the units of measurement, you need to select **mm** or **inches** in the **Units of measurement** field. After saving the changes, all information will be displayed in the selected units of measurement.

22.2. Database settings

22.2.1. Setting the path to database

It is possible for the user to change the drive and the directory of the profiles database storage. In the main window, select **File > Path to DB...**

Next:
- click **Ok**
- specify a new path to the database
- confirm the creation of a new database

All database files will be copied to the specified path.
22.2.2. Creation of empty database

To create an empty database, select File > New DB.

All data except the reference files will be deleted from the database. At the same time, the DB(dd.mm.yy) directory will be created in the installation directory whereto all the deleted data will be copied (dd.mm.yy – current date). If necessary, these data can be restored (see par. 22.2.3).

22.2.3. Import of database

To import data to the database from the other database, you need to:
- Select File > Import Data.
- Select the directory with DB files in the left window. All files will appear in the right window:

- Click OK to import data.

22.2.4. Selection of software language

To change the software language, select Settings > Language and select the required language support file.
22.2.4.1. Preparation and installation of the language support file

The user can change the language, form his own language support files as well as change/edit the terminology used. Language support files are located in the directory used in the process of installation. By default, the following directory is used: C:\Program Files (x86)\Riftek, LLC\ikp5_db\Language. The directory contains two files, RUS.lng and ENG.lng, to support Russian and English languages respectively.

To create the support file for any other language, it is necessary to:

- copy one of the existing files, for example - ENG.lng, under the other name, for example - DEU.lng;
- edit the renamed file by using any text processor, namely, change all terms and phrases to analogous ones from the required language;
- save the edited *.lng file in the Language directory.

To change and edit terminology, it is necessary to:

- edit the corresponding language file by using any text processor;
- save the edited *.lng file in the Language directory.

22.3. Registration data

22.3.1. Selection of the organization

To add/chose the user organization, select Registration > Organization. Subsequently, this information will be used in automatic generation of reports.

Buttons:

- Add: Add a new organization
- Delete: Delete the selected organization
- Edit: Edit the selected organization
- Exit: Exit the mode

To select a current organization:

- Click Edit
- Tick the depot
- Click Save
22.3.2. **Registration of operators**

Steps to follow: **Registration > Operator**. Operators data are used for identifying operators by **Number**.

Functions of buttons are similar to those in par. 22.3.1.

22.3.3. **Registration of series**

Steps to follow: menu **Registration > Series**. Registered series of cars or locomotives are displayed in the emerged window.

When registering a new series, a new entry for this series will be added in the table of tolerances automatically (see par. 22.3.5).

Functions of buttons are similar to those in par. 22.3.1.

When adding a new series, it is necessary to enter the name of the series and to select the reference profile for it. Flange parameters of the selected profile will be calculated and added to the table of tolerances automatically after saving the series (see par. 22.3.6).
22.3.4. Registration of car/locomotive numbers

Steps to follow: menu Registration > Number. Registered numbers of cars/locomotives are displayed in the emerged window.

Functions of buttons are similar to those in par. 22.3.1.

22.3.5. Registration of tolerances

Steps to follow: menu Registration > Tolerance. Registered series of cars/locomotives with boundary values of calculated geometric parameters of the wheelset are displayed in the emerged window.

Only parameters, which were selected in the list of parameters, are available for editing (see par. 22.1.2.).

Maximum/minimum critical values of parameters are indicated with a red color. An orange color indicates maximum/minimum values of parameters, which are close to critical.

The Norm value is calculated and added to the table automatically when adding/editing the series of the selected reference (see par. 22.3.3).

22.3.6. Registration of reference profiles

The program comes with several preset profiles. In addition, the supplied disc with software contains the base of reference profiles. Profiles are in the Reference Profiles directory and divided into separate directories for each country.

In addition, the user can form a description of the required profile himself or request it from RIFTEK (free service).

To browse available profiles, select Registration > Reference:
The window of profiles displays the table with the list of reference profiles, saved to database, and a graphical view of the selected profile.

**Buttons:**

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Delete" /></td>
<td>Delete the reference profile</td>
</tr>
<tr>
<td><img src="image" alt="Import" /></td>
<td>Import the reference profile from *.ref file</td>
</tr>
<tr>
<td><img src="image" alt="Export" /></td>
<td>Export the reference profile to *.ref file</td>
</tr>
<tr>
<td><img src="image" alt="Exit" /></td>
<td>Exit the mode</td>
</tr>
</tbody>
</table>

### 22.3.6.1. Request and registration of the profile file

To get .ref file of reference profile send the drawing of profile to RIFTEK (info@riftek.com). Register the received .ref file as follows:

- Click **Import**
- In the window appeared indicate the way to the .ref-file
- Click **Open**

The profile will be added to the base of reference profiles.
23. Data exchange between PDA and PC

To exchange data between PC and PDA, you need to select the device: File > Device > RF303M-PDA.

Data exchange between PC and PDA is performed by means of direct cable connection of PDA to PC USB-port (special RF505.42 cable is supplied).

There are two ways of synchronization via USB cable:
- ActiveSync
- Mass Storage

For more details see par. 21.2.

23.1. ActiveSync synchronization

When you select this type of synchronization, additional features of data exchange with PDA will be available:
- Transfer of database files to PC
- Transfer of language files
- Transfer of reference profile files
- Transfer of processing scheme files
- PDA software update

23.1.1. Transfer of database file to PC

To transfer the database file from PDA to PC, it is necessary to:
- select PDA > Import Data

- mark the required files in the emerged window and click OK
23.1.2. Transfer of language file from PC to PDA

To transfer the language file from PC to PDA, it is necessary to:

- select PDA > Language file > Export

- select the required file
If transfer is successful, the screen will show:

![Icon showing successful transfer](image)

### 23.1.3. Transfer of language file from PDA to PC

To transfer the language file from PDA to PC, it is necessary to:

- select **PDA > Language file > Import**

![Select files dialog](image)

- select the required file

If transfer is successful, the selected files will be saved to the specified path.

### 23.1.4. Transfer of reference profile files from PC to PDA

To transfer the reference profile file from PC to PDA, it is necessary to:

- select **PDA > Reference file > Export**

![Select files dialog](image)
• select the required .ref file
If transfer is successful, the screen will show:

23.1.5. Transfer of processing scheme file from PC to PDA

To transfer the processing scheme file from PC to PDA, it is necessary to:
• select PDA > Scheme file > Export

• select the required .sch file
If transfer is successful, the screen will show:

23.1.6. Updating of PDA software

The latest software version can be downloaded from the website: 
www.riftek.com/media/documents/ikp/ikp5_PDA_Software.zip.
To transfer the update file to PDA, it is necessary to:
• select PDA > PDA update

• select file for transfer
If transfer is successful, the window will appear:

![Image of transfer success window]

### 23.2. Mass Storage synchronization

When you select this type of synchronization, PDA is detected as an external storage device. Therefore, the only **Import Data** item is active. Transfer of language/scheme/reference files from PDA to PC and back can be performed by simple copying.

To transfer database files from PDA to PC, it is necessary to:
- select **PDA > Import Data**
- specify the path to the database on PDA (by default, `SDMMC\Autorun\DB`)
- mark the required files in the emerged window and click **OK**

Double-click on the selected file in order to see information about saved data.
24. Working with profilograms and wear calculations

24.1. Browsing the graph and profile coordinates

To browse the saved profiles of the rolling surface, select Database > Profiles, or click the Profiles button.

At the left side of the window you can see the Table of profiles tab, which contains a list of saved profiles. The table displays only those identification parameters of the wheel, which were selected in the parameters window (see par. 22.1.).

When selecting a profile, it is possible to browse a graphical image and geometric parameters of the measured wheel. To browse the coordinates of the selected profile, you need to click the Profile Values button. After that, an additional tab with the measured coordinates will appear.

Buttons:

- Show/hide the Wear graph
- Show/hide the Profile Values tab
- Show/hide the Profile alignment tab
- Save the profile image to file (.bmp file)
- Print the profile image
- Change the background color of the graph
- Zoom in/out the profile graph
- Calculate geometric parameters of the wheel
24.2. "Parameters" tab

Calculated geometric parameters of the profile as well as L-parameters values are displayed on the Parameters tab, which is at the bottom of the window.

If needed it is possible to change settings of the calculated parameters or support points (see par. 22.1).

24.2.1. Selecting a profile to compare

There are two ways to compare:
- with the reference profile,
- with the measured profile.

To compare the measured profile with the reference one, it is necessary to tick the Reference box.

When comparing with the reference profile, select the required reference profile in the drop-down list.

To compare two measured profiles (for example, profiles of left and right wheels), it is necessary to tick the Measured box. The Table of profiles tab will show an additional table for selecting a profile to compare.

24.2.2. Selecting L-parameters values

When calculating the geometric parameters of wheelsets, the specified support points are used (see par. 22.1.3). There are two variants of L-parameters:
- General parameters
- Profile parameters

When selecting General parameters, values of L-parameters will be taken from the default parameters file (see par. 22.1.3).

When selecting Profile parameters, values of L-parameters will be taken from the profile file, i.e. the values, which were set in PDA when measuring the wheelset (see par. 14.3).

Values of L-parameters are displayed on the screen in the table of parameters.
If necessary, it is possible to edit any value and to recalculate values of geometric parameters of the flange. To do it, click **Calculate**. Parameters of the measured profile and selected reference will be recalculated.

### 24.2.3. Geometric parameters of the profile

The table of calculated geometric parameters displays only those parameters, which were selected in the parameters window (see par. 22.1.2).

<table>
<thead>
<tr>
<th>Code</th>
<th>Measured</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>20.82</td>
<td>20.00</td>
</tr>
<tr>
<td>Thickness</td>
<td>31.83</td>
<td>32.32</td>
</tr>
<tr>
<td>Gradient</td>
<td>-0.03</td>
<td>0.10</td>
</tr>
</tbody>
</table>

Parameters, which are beyond the set tolerances, are highlighted in red/orange (see par. 22.3.5).

### 24.3. Wear calculation

#### 24.3.1. Fast wear calculation

To obtain fast calculation of the profile wear at a certain point relative to the reference, put cursor bar to any of the profiles, and when a cross-like (+) mouse cursor appears press the left mouse key. The resulting screen will show the value of the coordinate difference between profiles taken along X- and Y-axes, as shown by arrows:

To remove size indication from the screen, it is necessary to put cursor to any of the profiles and press the right mouse key.
24.3.2. Wear calculation at all points

To calculate the wear at all points of the measured profile, it is necessary to click the **Wear** button. Calculated wear will be displayed on the screen in a graphic form:

![Wear calculation graph](image)

The graph displays positive and negative values of the wear area. Value of the wear area is calculated in square millimeters with respect to the selected reference profile:

\[ \text{Wear (mm}^2) = 203.133 - 22.711 \]

To view the table of wear values, it is necessary to select **Profile Values > Wear**. The table will show deviations of the selected profile from the reference profile in two directions (X and Y).

![Wear values table](image)

24.3.3. Export to Excel, DXF, REF

To export the table to the Excel or DXF format or to create the reference file (REF), it is necessary to right-click on the table. The pop-up menu will appear:

- Export to Excel
- Export to DXF
- Export to REF
Select the needed menu item.

24.4. Alignment of profiles

For alignment (vertical translation) of profiles, you need to click the Alignment button. The program will display an additional tab, where you can select a profile: Reference or Measured. The selected profile will be marked with red.

After selecting the profile, the screen will display the maximum and minimum deviations of the selected profile from the reference profile \( \text{Min} \ dY..\text{Max} \ dY \).

Next, specify the translation step and move the profile by using the Up/Down, Left/Right buttons.

To save the changed profile, go to the tab of identification parameters of the profile and click Save.

To create a new profile, it is necessary to change the identification parameters of the profile.
24.5. **Superposition of profiles**

To superimpose several changed profiles, you need to tick the required profiles in the left table. Selected profiles will be displayed in different colors.

![Image of superposition of profiles]

24.6. **Rescaling**

To change the image scale, mark a part of the image with the left mouse key, move the image by holding it with the right mouse key pressed, or with buttons [Increase](#), [Decrease](#), and [Show all](#).

![Image of rescaling]

25. **Implementation of minimum wheel truing function**

Select Tools > Analysis of profiles. The analysis of wheel profiles allows to choose such a type of the profile from the reference profiles, for which the total truing depth of two wheels would be minimal.

In the first table of profiles, select the first required profile of the wheelset (left wheel); in the second table of profiles, select the second required profile of the wheelset (right wheel).

The program allows to perform the automatic analysis by all the reference profiles, which stored in the database, or by the selected profile only.
- Automatic analysis
Tick the box and click the **Analysis** button. Profiles in the table of references must not be marked.

- **Analysis by the selected profile**

Select the reference profile for analysis and click the **Analysis** button.

To know the wheel cutting depth in a certain point, put the cursor to any profile, and when a cross-like (+) mouse cursor appears press the left mouse key. The resulting screen will show the value of difference between profiles along X- and Y-axes, as shown by arrows. To remove size indication from the screen, put cursor to any of the profiles and press the right mouse key.
26. Scanning and editing of data

26.1. Scanning and filtering of data

Select **Database > Table** in the menu or click the **Table** button - . The form with results will be as follows:

- **Hide/show the field**
  The table displays the identification and geometric parameters of the wheelset, which are selected for displaying in the parameters settings (see par. 22.1.1 and 22.1.2).

- **Sorting of data**
  To sort data for any of the fields, click the left mouse key on the header of the field column:

<table>
<thead>
<tr>
<th>Measurement date</th>
<th>Measurement time</th>
<th>Wheelset</th>
</tr>
</thead>
<tbody>
<tr>
<td>03.12.2015</td>
<td>12:56:49</td>
<td>1</td>
</tr>
<tr>
<td>03.12.2015</td>
<td>12:57:33</td>
<td>2</td>
</tr>
<tr>
<td>03.12.2015</td>
<td>16:19:34</td>
<td>1</td>
</tr>
<tr>
<td>03.12.2015</td>
<td>17:05:10</td>
<td>1</td>
</tr>
</tbody>
</table>

  To cancel data sorting, press the **Ctrl** key and click the left mouse key on the header of the field column.

- **Filtering of data**
  In order to filter data in any of the fields, click the left mouse key on the header of the field grouping, and select the required value in the emerged drop-down list:

<table>
<thead>
<tr>
<th>Measurement date</th>
<th>Measurement time</th>
<th>Wheelset</th>
</tr>
</thead>
<tbody>
<tr>
<td>06.01.2016</td>
<td>11:03:03</td>
<td>SU000111</td>
</tr>
<tr>
<td>06.01.2016</td>
<td>11:03:03</td>
<td>SU000112</td>
</tr>
<tr>
<td>06.01.2016</td>
<td>11:03:03</td>
<td>SU000113</td>
</tr>
<tr>
<td>06.01.2016</td>
<td>11:03:03</td>
<td>SU000114</td>
</tr>
</tbody>
</table>

  To cancel filtering, all steps should be taken in the reverse order.
• **Data grouping**
  To group data for any of the fields, click the left mouse key on the header of the field column, and, with the mouse key pressed, drag it onto the table header:

  ![Image](image1)

• **Changing of the field position order**
  To change the field position, click the left mouse key on the header of the field column and, with the mouse key pressed, drag it to the required position:

  ![Image](image2)

  **Buttons:**
  - Add the wheel pair
  - Delete the selected wheel pair
  - Delete all wheel pairs
  - Edit the selected wheel pair
  - Export the coordinates of wheel pairs to the Excel format
  - Report preparation

26.2. **Editing data**

You can edit, add and remove data in/from the database.

  • **Editing data**

  ![Image](image3)
To edit the current entry, click the **Edit** button and input/change required values of parameters. After the editing is complete, click the **Save** button.

- **Adding data**

To add a new data entry, click the **Add** button and type required parameter values. After the editing is complete, click the **Save** button.

- **Deleting data**

To delete the current entry, click the **Delete** button and confirm the deletion.

- **Deleting all selected data**

If it is necessary to delete not only one entry but several entries combined by some condition, filter the data according to the corresponding attribute (see par. 26.1.), click the **Delete all** button and confirm the deletion.

### 26.3. Report preparation

When staying in the mode of scanning and editing data, the user can prepare reports in **Excel, RTF, PDF** formats, or print out reports. When preparing the report, the sorting used at the moment is taken into account.

To generate a report, press the **Report** button. The program will offer to select the following options:
26.3.1. Excel-format report

To prepare a report in Excel format, select **Report in Excel** and click **OK**.

![Excel format report](image)

26.3.2. Report for printout

To prepare the report for printout, select **Report for printout** and click **OK**. Data will be presented in the form of report ready for printout.

![Report for printout](image)
The top toolbar contains the following buttons for operating with reports:

- To printout the report, click 
- To save in PDF format, click .
- To save in Excel, RTF or PDF, click and select the format you need:

27. Taking measurements under PC control (without PDA)

The laser scanning module (RF505) can work under direct control of PC without PDA. To work under direct control of PC, it is necessary to select File > Device > RF505-Profilometer in the main menu.

In the main menu of the program, the PDA tab will be replaced with the Profilometer tab.

The menu contains two available items:

- Calibration
- Measurement

Before you start working with the profilometer, it is necessary to set the COM-port for Bluetooth-connection between the laser scanning module and PDA. The procedure is described in the User's manual that comes with the Bluetooth-adapter.
27.1. Calibration

To calibrate the device, select Profilometer > Calibration, or click .

27.1.1. Bluetooth-connection

Select the COM-port and click the Connect button.

For more information, refer to p. 30.

If the connection is successful, the device will be identified, and calibration parameters will be obtained. The status will be changed to Connected.

The table of calibration parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Initial scanning position</td>
<td>30</td>
</tr>
<tr>
<td>Final scanning position</td>
<td>2880</td>
</tr>
<tr>
<td>Time of friction -&gt;</td>
<td>6</td>
</tr>
<tr>
<td>Time of friction &lt;-</td>
<td>5</td>
</tr>
<tr>
<td>Size increment position(Disk)</td>
<td>4925</td>
</tr>
<tr>
<td>Additional constant X-axis(beg)</td>
<td>5300</td>
</tr>
<tr>
<td>Corner of turn(All)</td>
<td>63</td>
</tr>
<tr>
<td>Connection factor(Koe1)</td>
<td>0</td>
</tr>
<tr>
<td>Connection factor(Koe2)</td>
<td>0</td>
</tr>
<tr>
<td>Leg size on 10 microns</td>
<td>0</td>
</tr>
</tbody>
</table>
Buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measurement</td>
<td>Measurement</td>
</tr>
<tr>
<td>Read param.</td>
<td>Reading calibration parameters</td>
</tr>
<tr>
<td>Write param.</td>
<td>Writing calibration parameters</td>
</tr>
<tr>
<td>Auto calibr.</td>
<td>Automatic setting of calibration parameters</td>
</tr>
</tbody>
</table>

The Auto calibration button will be active, if at least one measurement of the profile is performed and the reference profile is selected.

27.1.2. Calibration of the profilometer

- Place the profilometer on the calibration block.
- Select the reference profile from the list (Compare > Reference).
- Perform the measurement (the Measurement button).
- Perform the calibration (the Autocalibr button).
- Save calibration parameters (the Write param. button).

Calibration parameters can be set manually. To do it, click left mouse key on the field of the required parameter value, and enter the new one.

**Attention!** Writing incorrect values of some parameters can lead to the incorrect work of the device.

Buttons functions, work with profiles and calculation of required parameters are described in par. 22.
27.2. Measurement by using PC

To measure, select Profilometer > Measurement, or click the button.

![Image of Profilometer interface]

When the Bluetooth-connection is established (see par. 27.1.1), the Measurement button is active.

27.2.1. Saving of data

- Place the profilometer on the wheel
- Perform the measurement (the Measurement button)
- Enter the identification parameters of the wheelset

![Image of Wheel parameters interface]

- To save results, click Save
- The measured profile will be saved to the database

Buttons functions, work with profiles and calculation of required parameters are described in par. 22.

- Switch off the PDA (laser module)
- Connect the charging device to PDA (laser module)
- Connect the charging device to 220V AC
- Time of charging - 4 hours (full-charge indication: PDA - blue LED is lit; laser module - green LED is lit)
- Disconnect the charging device from 220V AC
- Disconnect the charging device from PDA (laser module)

**Attention!** Please follow the sequence of these points.

29. **Annex 2. Program for creating the measurement schemes**

To create the measurement schemes, use the special program **SchemeBuilder.exe**. When the program is started, the main window appears on the screen:

To form the scheme:
- Enter the number of cars
- Enter the number of axles in every car
- If the measurement of the car is performed in the reverse order, tick the box
- Select the type of the scheme
- Click the button to accept
- Next, enter parameters of all wheelsets sequentially for each car

- The fields **Axle** and **Car** are used to navigate through the scheme
Click the **Save scheme** button and enter the name of the scheme in the dialog box window.

The program allows to edit the existing scheme. To edit the scheme, click the **Load scheme** button and select the *.SCH file. After loading, you can edit and save the wheelset parameters.

To transfer the scheme file to PDA, use the procedure described in par. 23.1.5. **Clarification.** The measurement scheme is a text file with extension .sch. User can create and edit such file by using any text processor.

**Example:**

```
Scheme_EXAMPLE
{
  1d-|SM3|7102|1l|11|SU1|111|1r|1|SU1|111|2l|SU2|112|r|SU2|112|3l|SU3|113|1r|SU3|113|4l|SU4|114|1l|SU4|114;
  2d-|SM3|7202|1l|21|SU2|211|1r|2|SU2|211|2l|SU2|212|r|SU2|212|3l|SU2|213|1r|SU2|213|4l|SU2|214|1l|SU2|214;
  3d-|SM3|7302|1l|31|SU3|311|1r|3|SU3|311|2l|SU3|312|r|SU3|312|3l|SU3|313|1r|SU3|313|4l|SU3|314|1l|SU3|314;
  4i-|SM3|7402|4r|44|SU044|414|4l|4|SU4|414|3r|SU4|314|3l|SU4|314|2r|SU4|214|2l|SU4|214|1r|SU4|114;
  5i-|SM3|7502|4r|54|SU054|514|4l|5|SU5|514|3r|SU5|314|3l|SU5|314|2r|SU5|214|2l|SU5|214|1r|SU5|114;
  6i-|SM3|7602|4r|64|SU064|614|4l|6|SU6|614|3r|SU6|314|3l|SU6|314|2r|SU6|214|2l|SU6|214|1r|SU6|114;
}
```

Where:
- 1d – coaches arranged in direct order (1 – sequence number)
- 1i – coached arranged in the reverse order (1 – sequence order)
- SM3 – coach series
- 7102 - number
- 1l – sequence number of wheel pair and the side (l- left/ r-right)
- 11 – axle number
- SU1 – name of wheel set
- 111 – running distance of wheel set
30. **Annex 3. Testing and calibration**

We can supply the profilometer complete with an RF505.11 calibration-wheel simulation unit (Fig. 1A) and **RF505Calibr** calibration program that are designed for periodic testing and self-calibration of the profilometer. Instead of the calibration unit use can be made of the wheel with known profile entered to the database (see par. 22.3.6).

Before start the testing and calibration process, it is necessary to set the COM-port for Bluetooth-connection between the laser scanning module and PDA. The procedure is described in the user manual that comes with the Bluetooth-adapter.

When you add the device, Windows will ask for the pairing code. The pairing code for each device consists of 4 symbols and is formed according to a serial number. For example, if a serial number is 04217, then a code will be 0427; if a serial number is 01318, then a code will be 0138, etc.

### 30.1. Preparation for testing/calibration

- Install the **RF505** program on the PC
- Install Bluetooth-connection between the scanning module and PC
- Place the profilometer on the calibration unit
- Run **RF505** program

To install Bluetooth-connection, select the required port. The device will be identified, and calibration parameters will be read.

- To perform the measurement, pass to the **Profile** tab and click **Measurement**. After measuring, the display will show the measured profile and the calculated
geometric parameters of the profile: Height (Sh), Thickness (Sd), Slope (qR). Parameters are measured at support points L1, L2, L3.

- To compare with the reference, tick the **Compare** box and select the required reference profile in the **Reference** drop-down list.

30.2. **Testing**

To carry out automatic testing, do the following steps:
- Tick the **N meas.** box (number of measurements)
- Specify the number of measurements (5-10)
- Click the **Measuring** button

The scanning module will make the specified number of measurements whose results will be entered to the table (the **Data** tab). The first three columns will present measured values of height (Sh), thickness (Sd), and flange slope (qR), while the other three columns will present deviations of the measured values from the reference values (d_Sh, d_Sd, d_qR).
The Diagram tab is intended for displaying the diagram of values/deviations of the measured profile from the selected reference. Deviation of the flange height and thickness from the reference values must not be more than 0.1 mm. If deviations exceed the permissible value, it is necessary to perform calibration of the scanning module.
30.3. Calibration

To carry out automatic calibration, do the following steps:

- Select the reference profile from the list
- Perform the measurement (the Measuring button)
- Perform the calibration (the Auto calibration button)
- When scanning is complete, perform the testing procedure in accordance with 30.2. In case of positive result, save parameters:
  - Right-click on the table and select Write
  - Right-click on the table and select Write to FLASH
30.4. Restoring the factory settings

If parameters have incorrect values (negative or zero), it is necessary to restore the factory settings by pressing the **Load Default** button. After that, recalibrate the profilometer.

![Image](image.png)

Figure 1A

When working with the A.U.R.A. Wheel system from NEM Solutions, the laser scanning module is controlled by the special software application installed on a tablet computer.

31.1. Installation

To install the software, select and run the **Ikp5_Tablet.exe** file. Follow the guidelines in dialog boxes of the Installation Wizard. By default, the software will be installed in the following directory – **C:\Program Files (x86)\Riftek, LLC\Ikp5_Tablet**.

To start the program, press **Start > All programs > Riftek, LLC > Ikp5_Tablet > Ikp5_Tablet.exe**. The main window is shown below:

31.2. Settings

Before starting to work with the profilometer, it is necessary to configure parameters.

Press the **Settings** button. The program will require a password. When initially installed, the program accepts the following password: 1111. How to change the password, see Par. 31.2.3.
Enter the password and press Ok. The window of program settings will appear.

31.2.1. Language

The user can change the language, form his own language support files as well as change/edit the terminology used. To select the language, press Language, select the language support file, and press Select.

How to create the language support file, see Par. 22.2.4.1.

31.2.2. Gauge type selection

The program allows to work with the following gauges: IKP, IDK, IMR. When selecting one of them, you will see a list of available devices (i.e. devices that have been connected earlier).

Select the gauge and press the Select button. Parameters of the selected gauge will be used to connect to it. If the device is not in the list, you can add it – press the Add button and start to search for Bluetooth devices.
Press **Start** and wait for the search to complete.

The detected devices with their serial numbers will appear:
Select the device and press **Pair gauge** to include it in the list. Windows will report an attempt to add a new device, and request a pairing code.

If the pairing code is correct and the device is successfully added, the system will display a message. The device installation may take some time. The pairing code for each device consists of 4 symbols and is formed according to a serial number. For example, if a serial number is 04217, then a code will be 0427; if a serial number is 01317, then a code will be 0137, etc.

Select the device by pressing the **Select** button.
If you do not use the device anymore, you can delete it by pressing the Delete button. Similarly, you can add other gauges (IDK and IMR).

31.2.3. **Password**

To change the password, press **Password**.

```
Settings - Password

Gauge
Language
Gauge type
Password
Parameters
Calculation method
Displayed parameters
L parameters
Tools
Vehicle
Reference
Tolerance
Scheme
```

Enter a new password, confirm it, and press **Save**.
31.2.4. Calculation methods

Press Calculation method. On the screen:

To save the changes, press Save.

31.2.5. Selection of displayed parameters

Press Displayed parameters. On the screen:

In order to select/deselect a parameter, set ON/OFF in the Show/Hide column. To save the changes, press Save.
31.2.6. **L-parameters**

Press **L parameters**. The table displays only those L-parameters that are necessary to calculate the selected geometrical parameters of the wheel.

![Settings - L parameters](image)

To save the changes, press **Save**.

### 31.2.6.1. Preset values

<table>
<thead>
<tr>
<th>L-parameter</th>
<th>Default value</th>
<th>Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td>L1</td>
<td>2 mm</td>
<td>Used for calculation of the flange slope (qR)</td>
</tr>
<tr>
<td>L2</td>
<td>70 mm</td>
<td>Defines position of the wheel rolling circle, and used for calculation: - flange height (sH) - flange thickness (sD) - flange slope (qR) - inclination angle (A) - wheel diameter (D) - rim thickness (T) - wear (Wt, Wf, Wr)</td>
</tr>
<tr>
<td>L3</td>
<td>13 mm</td>
<td>Used for calculation: - flange thickness (sD) - flange slope (qR) - wear (Wf)</td>
</tr>
<tr>
<td>L4</td>
<td>13 mm</td>
<td>An additional point for calculation of the flange slope (qR)</td>
</tr>
<tr>
<td>L5</td>
<td>10 mm</td>
<td>Used for calculation of an angular wear (Wr)</td>
</tr>
<tr>
<td>L6</td>
<td>70 mm</td>
<td>Used for calculation of slope of the rolling surface section (S1)</td>
</tr>
<tr>
<td>L7</td>
<td>105 mm</td>
<td>Used for calculation of slope of the rolling surface section (S2)</td>
</tr>
<tr>
<td>L8</td>
<td>10 mm</td>
<td>Used for measurement of the profile inclination angle at the required point (A)</td>
</tr>
<tr>
<td>L9</td>
<td>140 mm</td>
<td>Used for inverting the measurement direction (L9 – profile width)</td>
</tr>
<tr>
<td>L10</td>
<td>599.35 mm</td>
<td>Used for calculation of the profile diameter (D)</td>
</tr>
<tr>
<td>L11</td>
<td>767 mm</td>
<td>Used for calculation of the reference profile rim thickness (T)</td>
</tr>
<tr>
<td>L15</td>
<td>13 mm</td>
<td>Used for calculation of the flange thickness of tram wheels (sD15)</td>
</tr>
</tbody>
</table>
### 31.2.7. Reference profile selection and installation

The program allows to compare the scanned profile of the wheel with the reference profile. To select the reference profile, press **Reference**.

<table>
<thead>
<tr>
<th>P7_1</th>
<th>50 mm</th>
<th>Used for calculation of the hollow (HI)</th>
</tr>
</thead>
<tbody>
<tr>
<td>P7_2</td>
<td>105 mm</td>
<td></td>
</tr>
<tr>
<td>P8_1</td>
<td>110 mm</td>
<td></td>
</tr>
<tr>
<td>P8_2</td>
<td>130 mm</td>
<td></td>
</tr>
<tr>
<td>D1</td>
<td>70 mm</td>
<td>Used for calculation of the hollow (HI)</td>
</tr>
<tr>
<td>D2</td>
<td>107.5 mm</td>
<td></td>
</tr>
</tbody>
</table>

To delete the reference file, activate the line and press **Delete**.
To add the reference file, press **Import** and select the *.ref file.

### 31.2.7.1. Writing the reference profile to the database

Reference profiles are stored in the database as profile description files with the .ref extension. The software is supplied with several preset profiles.

If there is no required reference profile in the database, the user can request the missing profile from RIFTEK (free service).

### 31.2.8. Measurement scheme

The measurement scheme is meant as a sequence of making measurements/processing of wheels in the rolling stock with specified parameters of each wheelset (wheelset numbers, car numbers, series, etc.). The program automatically offers the operator to perform measurement of the wheel in accordance with selected scheme of wheel processing. The program contains several preset schemes. Besides, the user can form his own measurement scheme.
31.2.8.1. **Selection or removal of the measurement scheme**

To select the measurement scheme file, press **Scheme**.

![Scheme](image)

Arrows in the figure show the direction of processing of wheelsets as well as the names assigned to wheels.

To delete the scheme file, activate the line and press **Delete**. If you delete the current scheme, the error message will appear.

To add the scheme file, press **Import** and select the ***.sch** file.

31.2.8.2. **Formation of a new measurement scheme**

To form a new measurement scheme, press **Add**. The following window will appear:

![Add](image)

Next:
- enter the scheme name;
- select the number of cars;
- select the number of axles;
- select the wheel processing scheme out of the options suggested;
• press **Ok**.

This method of the measurement scheme formation allows to create only simple schemes without specifying the wheelset numbers, car numbers, series, etc. To form a complete scheme, see par. 29.

### 31.2.9. Tolerances

The program automatically controls measured geometric parameters for going out beyond the tolerances set. It is possible for the user to create groups of tolerances. Control of parameters will be performed for a selected group.

To select a current group of tolerances, press **Tolerance**. The table will show tolerances only for the selected geometric parameters of the wheel.

A red color indicates the maximum/minimum critical values of parameters. An orange color indicates the maximum/minimum values, which are close to critical values.

To delete the tolerance, activate the line and press **Delete**.

To edit the tolerance, activate the line and press **Edit**.

To add a new tolerance, activate the line and press **Add**. On the screen:
Enter the tolerance name into the **Name of tolerance** field and the values into the **Min/War.Min/War.Max/Max** fields. To save the changes, press **Save**.

### 31.2.10. Vehicles

To view a list of rolling stocks, press **Vehicle**. The listed rolling stocks can be selected for measurement.

**Parameters of the rolling stocks:**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vehicle name</td>
<td>Name of the rolling stock</td>
</tr>
<tr>
<td>Vehicle Id</td>
<td>Identification number of the rolling stock</td>
</tr>
<tr>
<td>Vehicle description</td>
<td>Description of the rolling stock</td>
</tr>
<tr>
<td>Schedule</td>
<td>Schedule for the rolling stock</td>
</tr>
<tr>
<td>Send to AURA</td>
<td>Select &quot;Yes&quot; if you want to send data to the AURA database, or select &quot;No&quot; if you don't</td>
</tr>
<tr>
<td>Scheme</td>
<td>Measurement scheme name</td>
</tr>
<tr>
<td># axles</td>
<td>Number of axles</td>
</tr>
<tr>
<td># wheels</td>
<td>Number of wheels</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference name from a list of references (Reference tab)</td>
</tr>
<tr>
<td>Tolerance</td>
<td>Tolerance name from a list of tolerances (Tolerance tab)</td>
</tr>
</tbody>
</table>

To delete the rolling stock, activate the line and press **Delete**.

To edit the rolling stock, activate the line and press **Edit**.

To add a new rolling stock, activate the line and press **Add**.

### 31.3. Measurements

There are three types of measurements:

1. **Single Measurement** – measurement without specifying the rolling stock type, measurement scheme, tolerances. Measurement results can be saved to the WMC format.

2. **Simple Measurement** – measurement of the selected rolling stock with specifying the scheme and tolerances. Measurement results are saved to the WMC format.
3. Automated Measurement – measurement of the selected rolling stock with specifying the scheme and tolerances. Measurement results are transferred to the AURA database.

31.3.1. **Single measurement**

To enter the mode, press the **Single Measurement** button.

![Single Measurement Interface]

First, you need to establish the Bluetooth connection to the gauge: IKP, IDK or IMR.

![Bluetooth Connection Interface]

The list contains devices selected in settings (see Par. 31.2.2, "Gauge type selection"). After selecting, press the **Connect** button.

![Connect Button]

The **Measurement** button and the charging indicators will be active.

- Press the **Measurement** button.
- After pressing the **Measurement** button, the laser module starts scanning of the wheel surface. During the scanning process (1-2 seconds), a red LED is lit.
- When the scanning process is complete, the program displays the measurement results.

![Measurement Results]
Measurement results and profile coordinates can be saved to the file of the WMC format. The files are saved to the following directory:
C:\Riftek, LLC\Ikp5_Tablet\Measurements\Losse metingen\n
The IDK is designed to measure the wheel diameter. The IMR is designed to measure the back-to-back distance. In order to change the gauge type, press the Disconnect button, select the gauge you need, and press Connect.

The measurement procedure is similar to IKP.

31.3.2. Simple measurement

To enter the mode, press the Simple Measurement button. This mode allows to perform measurements in accordance with the rolling stock parameters (scheme, tolerances, reference).

First, you need to select the rolling stock in the Select Vehicle window. The list contains only those rolling stocks, the measurement results of which will not be sent to the AURA database (the Send to AURA column is empty).
Select the rolling stock (or specify its name in the search line) and press OK. The program will show the measurement scheme and parameters for the selected rolling stock.

Next, select and connect the gauge: IKP, IDK or IMR. The connection procedure is described in the previous paragraph.

When the connection is established, the Measurement button will be active and you can start measurements.
Designations and buttons:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td>an ordinal number of the car to be measured (number of cars in the rolling stock)</td>
</tr>
<tr>
<td><img src="image2.png" alt="Image" /></td>
<td>pass to the previous/next wheel</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td>pass to the previous/next car</td>
</tr>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td>a measured wheel</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td>a wheel to be measured the next time</td>
</tr>
<tr>
<td><img src="image6.png" alt="Image" /></td>
<td>a non-measured wheel</td>
</tr>
<tr>
<td><img src="image7.png" alt="Image" /></td>
<td>parameters of the measured wheel are beyond the tolerances</td>
</tr>
<tr>
<td><img src="image8.png" alt="Image" /></td>
<td>parameters of the measured wheel are close to the tolerances</td>
</tr>
<tr>
<td><img src="image9.png" alt="Image" /></td>
<td>measurement</td>
</tr>
</tbody>
</table>

### 31.3.2.1. Measurement

- Press the **Measurement** button in order to measure the wheel offered by the program (highlighted in green). The laser module will scan the wheel surface.
- Upon completion of the scanning process, the program will show the values of selected geometrical parameters.
When the value is beyond the tolerances, it will be highlighted in red:

The program allows to display only parameters of the measured profile. To hide the reference values, you need to disable the Show Reference option (select “Off”).

- To repeat the measurement, press the Measurement button.
- When a satisfactory result is obtained, press the Save button to save it.
- The program will offer to pass to the measurement of the next wheel in accordance with the selected scheme of measurement.
To view the results of previous measurements, you can use the arrows. If you select the measured wheel, the program will display the saved wheel parameters.

When you measure the wheel that was already measured, the program prompts you to replace the existing values with the new ones.

The measurement results can be saved in the WMC format. Each measurement is saved in a separate file. The path:

C:\Riftek LLC\Kp5_Tablet\Measurements\WMC\HM780_20170830\WMC

Where HM780_20170830 is the directory name, HM780 is the rolling stock name, 20170830 is the date of measurement (yyyyymmdd).
31.3.2.2. Measuring by IDK, IMR

To measure the wheel diameter and back-to-back distance, disconnect from IKP by pressing the Disconnect button, and select the gauge you need: IDK (to measure the wheel diameter), or IMR (to measure the back-to-back distance).

The measurement process is similar to IKP.
The measurement results can be saved in the WMC format. Each measurement is saved in a separate file.

31.3.3. Automated measurement

The Automated Measurement mode as well as the Simple Measurement mode allows to perform measurements in accordance with the rolling stock parameters (scheme, tolerances, reference).

The only difference is that the list contains only those rolling stocks, the measurement results of which will be imported to the AURA database (the Send to AURA column is ticked).

**Attention!** The Internet connection is required in order to connect to the AURA database and to transmit data.

The measurement procedure has one difference from the Simple Measurement mode. In order to import data to the AURA database, it is necessary to measure all cars of the selected rolling stock according to the measurement scheme. Only in this case the Send to AURA button will be active.
After pressing the **Send to AURA** button, the data transmission window appears. In case of successful identification in the AURA system, the data transmission starts.

When the data is successfully transferred, the following message appears:
If any error occurs while connecting to the AURA system (for example, if there is no Internet connection), the error message appears.

In this case, you need to check the Internet connection and try to transmit data again by pressing the **Try Again** button.

To avoid the data loss, all measurement results are also copied to the directory:

```
C:\Riftek LLC\Kp5_Tablet\Measurements\ AURA\4002_20170830\n```

Where `4002_20170830` is the directory name, `4002` is the rolling stock name, `20170830` is the date of measurement (yyyymmdd).

32. **Warranty policy**

Warranty assurance for the Laser Profilometer – 24 months from the date of putting in operation; warranty shelf-life – 12 months.

33. **List of changes**

<table>
<thead>
<tr>
<th>Date</th>
<th>Version</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>17.05.2017</td>
<td>1.0.0</td>
<td>Starting document.</td>
</tr>
<tr>
<td>10.11.2017</td>
<td>1.1.0</td>
<td>Added section 31 'Software application for working with the A.U.R.A. Wheel system'.</td>
</tr>
</tbody>
</table>

34. **Distributors**

**AUSTRIA**

MBM Industry & Rail Tech GmbH
RAILWAY INSTRUMENTS ONLY
Tullnerbachstraße 36,
A-3002 Purkersdorf, Austria
Tel: +43 2231 66000
Fax: +43 2231 66000 12
office@mbm-industrietechnik.at
www.mbm-tech.at

**AUSTRALIA**

Applied Measurement Australia Pty Ltd
RAILWAY INSTRUMENTS ONLY
Thornton Plaza, Unit 5,
27 Thornton Crescent, Mitcham
VIC 3132, Australia
Tel: +61 39874 5777
Fax: +61 39874 5888
sales@appliedmeasurement.com.au
www.appliedmeasurement.com.au

**BENELUX**

Althen Sensors & Controls BV
Vlietweg 17a
2266KA Leidschendam
The Netherlands
Tel: +31 70 3924421
Fax: +31 70 3644249
sales@althen.nl
www.althensensors.com
www.althencontrols.com
BULGARIA, HUNGARY
RMT Ltd.
R Zahradni 224
739 21 Paskov, Czech Republic
Tel: +420 558640211
Fax: +420 558640218
rmt@rmt.cz
www.rmt.cz

BRAZIL
CAPI Controle e Automação Ltda
Rua Itororó, 121, CEP 13466-240
Americana-SP, Brazil
Tel: +55 19 36047068
Fax: +55 19 34681791
capi@capicontrole.com.br
www.capicontrole.com.br

CHILE
Verne SpA
Apoquindo 2818, oficina 31,
Las Condes, Santiago, Chile
Tel: +56 2 228858633
info@verne.cl
jsaavedra@verne.cl
www.verne.cl

CHINA
Beijing Gemston Mechanical & Electrical Equipment Co., Ltd
Room 613, Anfu Mansion, Fengtai District, Beijing, China
Tel: +86 10 6765 0516
Fax: +86 10 6765 9666
Mobile: +86 137 1755 1423
dh0526@163.com
www.baoft.cn

CHINA
JRKtech Co., Ltd.
1F, Building 9, 100 Xianlie Rd.,
Guangzhou, China
Tel: +86 755 85267190/
+86 15989362481
Fax: +86 755 85267190
shengz_k@163.com
www.jrktech.com

CHINA
Micron-Metrology co., ltd
No.2, Kecheng Rd., Industrial Park District, Suzhou, Jiangsu Province, China
Tel: 0512-65589760/
+86 189 1806 9807
sales@micron-metrology.cn
www.micron-metrology.cn

CHINA
Zhenshangyou Technologies Co., Ltd.
Rm 2205-2210, Zhongyou Hotel
1110 Nanshan Road, Nanshan District, Beijing, China
Tel: +86 10 6765 0516
Fax: +86 10 6765 9666
Mobile: +86 137 1755 1423
dh0526@163.com
www.baoft.cn

FINLAND
TERÄSPYÖRÄ-STEELWHEEL OY
RAILWAY INSTRUMENTS ONLY
Juvan teollisuuskatu 28
FI-02920 ESPOO, Finland
Tel: +358 400 422 900
Fax: +358 9 2511 5510
steelwheel@steelwheel.fi
www.teraspypora.fi

FRANCE
BLET Measurement Group S.A.S.
1 avenue du Président Georges Pompidou
92500 Rueil Malmaison, France
Tel: +33 (0)1 80 88 57 85
Fax: +33 (0)1 80 88 57 93
technique@blet-mesure.fr
www.blet-mesure.fr

GERMANY
Disynet GmbH
Breyeller Str. 2
41379, Brueggen
Tel: +49 2157 8799-9
Fax: +49 2157 8799-22
disynet@sensoren.de
www.sensoren.de

GERMANY
Finger GmbH & Co. KG
OPTICAL MICROMETERS ONLY
Sapeloh 172,
31606 Warmsen, Germany
Tel: +49 5767 96020
Fax: +49 5767 93004
finger@finger-kg.de
www.finger-kg.de

GERMANY
Hylewicz CNC-Technik
SHTRIHKH-2 ONLY
Siemensstrasse 13-15,
47608 Geldern, Germany
Tel: +49 2831 91021-20
Fax: +49 2831 91021-99
info@cnc-step.de
www.cnc-step.de

INDIA
Paragon Instrumentation Engineers Pvt. Ltd.
RAILWAY INSTRUMENTS ONLY
200, Station Road,
Roorkee, 247 667, India
Tel: +91-1332-272394
tanui@paragoninstruments.com
www.paragoninstruments.com

INDIA
Pragathi Solutions
#698, 5th Main, 8th Cross,
HAL 3rd Stage,
New Tippanahada Road,
Bangalore, 560075, India
Tel: +91 80 32973368
Tel/fax: +91 80 25239385
Mobile: +91 9448030426/
+9199448492380
sales@pragathisolutions.in
arghya@pragathisolutions.in
www.pragathisolutions.in
INDONESIA
PT. DHAYA BASWARA SANIYASA
Botanic Junction Blok H-9 NO. 7
Mega Kebon Jeruk, Joglo
Jakarta 11640, Indonesia
Tel: +62 21 29325859
management@ptdbs.co.id

IRAN
Novin Industrial Development Grp.
Tel: +98 21 44022093-6
Fax: +98 21 43858794
Mobile: +98 9123207518
info@novinid.com
www.novinid.com

ISRAEL
Nisso Dekalo Import Export LTD
1 David Hamelech Street
Herzlia 46661 Israel
Tel: +972-99577888
Fax: +972-99568860
eli@fly-supply.net
www.fly-supply.net
www.aircraft-partsupply.com

ITALY
FAE s.r.l.
Via Tertulliano, 41
20137 Milano, Italy
Tel: +39-02-55187133
Fax: +39-02-55187399
fae@fae.it
www.fae.it

JAPAN
Tokyo Instruments, Inc.
6-18-14 Nishikasai, Edogawa-ku,
Tokyo, 134-0088 Japan
Tel: +81 3 3686 4711
Fax: +81 3 3686 0831
f.kuribayashi@tokyoinst.co.jp
www.tokyoinst.co.jp

LATVIA, ESTONIA
SIA "SOLARTEX"
RAILWAY INSTRUMENTS ONLY
Duntes 15a, 5th floor, office B7
Riga, Latvia
Tel.: +371 67 130 787
solartex@inbox.lv

MALAYSIA
OptoCom InstruVentures
H-49-2, Jalan 5, Cosmoplex
Industrial Park, Bandar Baru
Salak Tinggi, Sepang, Malaysia
Tel: 603 8706 6806
Fax: 603 8706 6809
optocom@tm.net.my
www.optocom.com.my

NORWAY
Salitec AS
PB 468,
N-1327 Lysaker
Tel: +47 23 891015
Fax: +47 92101005
mail@salitec.no
www.salitec.no

PERU
Verne Perú S.A.C.
Las Codomices 104,
Surquillo, Lima, Peru
Tel/fax: +51 992436734
info@verne.cl
www.verne.cl

POLAND
MTL ASCO Sp. z o.o.
RAILWAY INSTRUMENTS ONLY
ul. Wielowiejska 53 44-120
PYSKOWICE (k/ GLIWIC),
Poland
Tel: +48 32 230 45 70
Fax: +48 32 332 70 14
rail@ascorail.eu
www.ascorail.eu

PORTUGAL
Campal Inovacoes Ferroviarias Lda.
RAILWAY INSTRUMENTS ONLY
Lagoas Park, Edificio 7, 1º Piso
Sul 2740-244 Porto Salvo, Oeiras,
Portugal
Tel: +351 21 584 4348
campal@campal.pt
www.campal.pt

RUSSIA
Sensorika-M LLC
Dmitrovskoye shosse 64-4
127474, Moscow, Russia
Tel: +7 499 487 0363
Fax: +7 499 487 7460
info@sensorika.com
www.sensorika.com

SOUTH AFRICA
Ratcom Enterprise Pty Ltd
CSIR BUILDING 35, Office 78
Meiring Naude Road, Brummeria
Pretoria, 0084 South Africa
Tel: +27 12 841 2032
Fax: +27 86 225 0650
info@ratcom.co.za
www.ratcom.co.za

RUSSIA
Diesel-test-Komplekt LLC
620030, Karjernaya St, 16
Ekaterinburg, Russia
Tel/fax: +7 343 2227565
Tel/fax: +7 343 2227370
mail@d-test.ru
www.d-test.ru

SERBIA, SLOVAKIA
RMT Ltd.
Zahradni 224
739 21 Paskov, Czech Republic
Tel: +420 558640211
Fax: +420 558640218
rmt@rmt.cz
www.rmt.cz

35. RIFTEK’s measurement devices for railway transport

Laser wheel profilometer. IKP Series
A laser profilometer is designed for the measuring of:
- wheel flange height;
- wheel flange thickness;
- wheel flange slope;
- full profile scanning and analyze of wheel rolling surface;
- maintaining of electronic wear data base;
- control of tolerances and sorting in the course of checkup, examination, repair and formation of railway wheel sets.
Measurements are made directly on rolling stock without wheel set roll-out.

Portable laser rail profilometer. PRP Series
The main functions of PRP are:
- obtaining the information on the cross-section profile of the working railhead surface;
- full profile scanning and analyze of the railhead acting face;
- visualization of the combined graphical images of actual and new cross-section railhead profiles on the display of system unit.

Wheel diameter measuring gauge. IDK Series
Electronic gauge is designed for measuring wheel rolling circle diameter of railway, metro and tram wheel sets.
Measurements are made directly on rolling stock without wheel set roll-out.
**Back-to-back distance measuring gauge. IMR Series**

Gauge is designed for contactless measuring of back-to-back distance of railway, metro and tram wheels in the course of checkup, examination, repair and formation of wheel sets. Measurements are made directly on rolling stock without wheel set roll-out.

**Back-to-back distance measuring gauge. IMR-L Series**

Gauge is designed for contactless measuring of back-to-back distance of railway, metro and tram wheels in the course of checkup, examination, repair and formation of wheel sets. Measurements are made directly on rolling stock without wheel set roll-out.

**Disc brakes profile gauge, IKD Series**

Laser disc brakes profilometer IKD Series is designed for disc brakes profile measuring. The main functions of IKD are:

- obtaining the information on the profile parameters of the working disc brakes surface;
- full profile scanning and analyze of the disc brakes acting face;
- visualization of the combined graphical images of actual and new disc brakes profiles on the display of system unit.

**Automatic real-time system for measurement of wheelsets geometrical parameters**

The system is designed for contactless automatic measurement of geometrical parameters of railway wheels and uses a combination of 2D laser scanners, mounted wayside in the track area.

The system can be easily installed at any type of rail infrastructure.